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As Star Wars: The Force Awakens breaks 
box office records around the world, we 
pay a visit to Industrial Light & Magic to 

discover what it took to create the movie’s 
stunning VFX. On page 40 read how leading 
artists mixed CG and practical effects to pay 

homage to the original trilogy. Plus, VFX 
legend Richard Edlund shares an unheard 
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Blanché, Josh Herman and Marko Ivanovic 
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amazing art – including cult bounty hunters 
Boba Fett and IG-88! 
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MOTHER OF DRAGONS
When creating this image 
of Khaleesi, Baolong 
most enjoyed using 
Unreal Engine 4 for 
materials and rendering 

8 3D WORLD  February 2016 www.facebook.com/3dworldmagazine

GET PUBLISHED

EMAIL YOUR CG ART TO
ian.dean@futurenet.com

ARTIST
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Visit the online Vault to download  
extra process art for these projects:

www.creativebloq.com/vault/3dw204



KHALEESI: THE 
THRONE IS MINE!

ARTIST  
Baolong Zhang
SOFTWARE Maya, ZBrush, 
Photoshop, Unreal Engine 4

Baolong Zhang honed his 3D craft working 
for Architecture VIZ before becoming an 
environment artist in video games. This 
broad background means Baolong has a 
comprehensive skill set, allowing him to create 
magnificent realistic images.

   Capturing the likeness of actress Emilia 
Clarke came easily to UK-based Baolong. 
Created in just a month-and-a-half, the image 
of the Mother of Dragons is the latest in the 
fantasy fan’s set of pictures inspired by George 
RR Martin’s books. “The most exciting part 
was using Unreal Engine 4 for the materials 
and rendering,” Baolong explains. “It was so 
challenging but also fun to work with.”

   Creating lifelike 3D images is a way for 
Baolong to channel all of his artistic research. 
“Traditional art has always been my biggest 
inspiration,” he says. “This includes everything 
from Chinese illustrations to western oil 
painting.” With Game of Thrones itself 
inspired by historical figures, he couldn’t have 
chosen a better character on whom to focus 
his wide range of influences.

FYI
See more of Baolong’s portfolio at   
www.baolongzhang.blogspot.co.uk

3D WORLD VIEW

“As a huge Game 
of Thrones fan I’m 
so impressed by 
Baolong’s super-
realistic image of 

Khaleesi. My favourite 
this issue.”

DARREN PHILLIPS
Art editor
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3D WORLD VIEW

“Luigi’s detailing 
has really paid off. 

I like how these 
contradictory 

characters are given a 
realistic feel.”

IAN DEAN
Editor

TIME TO PRACTISE 
Luigi used this 
project to develop 
his character 
building techniques
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SHOWCASE

REPAIRING BOT
ARTIST  
Luigi Monaldi
SOFTWARE 3ds Max, ZBrush, 
V-Ray, Photoshop

Currently working as a 3D character artist, 
Italy-based Luigi Monaldi keeps his creative 
skills sharp with his personal projects.
Completed over two months, Luigi’s Repairing 
Bot image was an ideal way to develop his 
character building techniques and channel his 
previous job as an environmental artist.

Details like the heart shaped tattoo and 
the combination of socks with slippers 
subtly present the mechanic’s contradictory 
character, while the scratches on the robot’s 
red bodywork ground the unusual scene and 
make it believable. “I’m inspired by artwork 
from every artist around the world,” says Luigi. 
This piece is no exception, as it was originally 
based on a doodle by Japanese visual 
development artist and animator Goro Fujita.

After gathering more reference images  
from Google, Luigi first modelled his 
characters in ZBrush before adding the hair 
with FiberMesh. “I recomb the hair with an 
imported spline,” he explains. “By using the 
hair texture in the tip and root channels, the 
colour is more natural.”

Rounding off the piece with the lighting 
and rendering was the most enjoyable part of 
the process for Luigi. Finishing touches, like 
adjusting the colour balance in Photoshop, 
helped him achieve the perfect atmosphere 
for this quirky piece.

FYI
Keep up to date with Luigi’s work at  
www.facebook.com/Giaigio3D

I’m inspired by artwork from 

every artist around

the world
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SHOWCASE

ROCKABILLY  
GIRL

ARTIST  
Fabio Wasques
SOFTWARE ZBrush,  
3ds Max, V-Ray, Photoshop

Working as a designer and freelance 3D artist 
is the latest step in a varied artistic career for 
Brazil-based creator Fabio Wasques. With 
a background in web design, Fabio worked 
with big clients such as Sony, Warner and EA 
Games before branching off in a new creative 
direction. “Most of my portfolio is based on 
3D modelling, texturing and rendering of 
characters,” he explains.
 Fabio has also experimented with 
animation, having produced a short movie 
called Serôdia for the Brazilian 3D school, 
Melies. “I’m always trying to apply new things 
to my own artwork,” he says. “All these 
challenges are very inspiring and make me 
keep going and try to get better.”

For his Rockabilly Girl, Fabio started by 
gathering as much research as possible, then 
he created the sculpt in ZBrush and made the 
hair using the 3ds Max Hair and Fur native 
system. “The most fun part of this project 
was bringing a little realism to the original 
concept,” he reveals. “Her tattoo was also 
very cool to paint.” Drawing inspiration from 
Antonio De Luca’s work, this image was 
whipped up in just 35 hours.

FYI
To see more of Fabio’s work head to 
www.fabiowasques.com.br

I’m always trying to apply 

new things to my 

own artwork

3D WORLD VIEW

“This is such a 
striking image. I 

especially like the use 
of 3ds Max to achieve 

the brilliant hair.”

FELICITY BARR
Production editor
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3D WORLD VIEW

“Zeno’s image was 
definitely worth the 
wait. The characters 
are great fun and the 
superb lighting really 

sets the mood.”

DARREN PHILLIPS
Art editor

MIND MAPPING
When it comes to 
shaders, Zeno tries to 
figure out how the maps 
look before he begins

PATH TRACER
ARTIST Zeno Pelgrims
SOFTWARE Maya, ZBrush,  
3D Coat, Mari, Knald,  
Arnold, Nuke

Path Tracer is the latest personal project by 
Belgian 3D artist Zeno Pelgrims. Currently in 
his final year of university at Bournemouth’s 
National Centre of Computer Animation, 
Zeno is already building a successful career 
in the industry. “Last year I got selected 
as Moving Picture Company’s modelling 
intern and this summer I worked on my first 
animated feature,” he explains.
 This project took Zeno a long time to 
complete as he had to juggle it around 
other work, however it was the lighting that 
brought the whole piece together. “This was 
where the whole mood of the image was 
created,” he reveals.
 Zeno’s enthusiasm for his work goes 
beyond the fun he finds in lighting decisions. 
“The magic ways of this absolutely stunning 
planet, and the dedication of people to 
literally practise a craft endlessly just to be 
able to express themselves as good as they 
can artistically – it’s all super inspiring.”
 This project was an opportunity for Zeno 
to test out new techniques. After the image 
was finished he used Sony’s SPI-animation 
OCIO profile in Nuke to display the scene-
linear image. “This gave me highlights that 
didn’t burn out and really improved the 
overall look of the image,” he says.

FYI
Watch the making of video in this issue’s 
Vault, or visit www.zenopelgrims.com



 I like all parts of 3D creation 

but particularly like sculpting

and texturing

GOBLIN  
SHAMAN

ARTIST Rafael C. Costa
SOFTWARE ZBrush,  
Modo 901, Photoshop,  
Marvelous Designer

Brazilian 3D artist Rafael C. Costa graduated 
in advertising and marketing before focusing 
on his real passion: creating detailed 3D 
images. Now working as a 3D generalist to 
create characters and scenes for games, 
Rafael loves to create images that people 
would not usually see. “My inspirations are 
design fundamentals, life, games, movies – 
everything that has art,” he explains.

Goblin Shaman is based on the fantasy 
art of Danish artist Jonas Jensen, with this 
image turning Jonas’ Fat Goblin King art into 
a 3D sculpt. Having tested out his character 
building skills with renders of Mega Man and 
the X Men’s Beast, the Goblin Shaman was 
the perfect chance for Rafael to develop his 
texturing skills. “I like all parts of 3D creation, 
but particularly sculpting and texturing,” he 
reveals. Working with Modo 901, it only took 
Rafael two weeks to create the thin, clammy 
skin with green veins running just beneath  
the surface. 

Using Jonas’ image as a guide, Rafael 
tweaked the positioning of the camera, the 
goblin’s pose and the lighting to bring out 
some of the finer details. “In other projects 
I create my own concept art with some 
sketches, but I’m always keen to follow the 
rules of design,” he adds.

FYI
See more of Rafael’s detailed characters at 
www.artstation.com/artist/rafaelccosta

3D WORLD VIEW

“Rafael has certainly 
developed his 

texturing skills. The 
goblin’s realistic 

skin is particularly 
impressive.”

IAN DEAN
Editor
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If the gender gap is closing, why are there still so few women  
working in the industry? Julia Sagar asks the experts 

IS THE CG INDUSTRY GENDER-EQUAL? 

Although there are 
more women entering 
the CG industry many 
experts feel a gender 
imbalance still exists

THE BIG ISSUE

Is the CG industry a gender-equal 
playing field? Why are there so few 
women at the top, and what are the 

biggest obstacles preventing women 
from making it in the industry? These 
were just some of the questions 
discussed by Sony’s Tara Saunders, 
Escape Studios’ 2D head and 
compositing instructor Davi Stein, and 
film journalist Helen O’Hara in a recent 
hour-long live webinar, Women in 
Industry, hosted by Escape Studios.

All extremely successful in their own 
fields, none of the women reported 
facing barriers based on their gender. 
Yet according to CG Architect’s 2015 
survey, women represent just seven per 
cent of the architectural visualisation 
industry, and it was only a year ago 
that Marvel’s vice president of post 
production Victoria Alonso called for 
more women to work in VFX, during the 
VES Summit. So where are the women?

According to Victoria, some of the 
obstacles that contribute to the gender 
gap in VFX are family related, including 
global production – which sees artists 
on location for months at a time, the 
long, 16-hour days of VFX production, 
and maternity leave. “If you take a 
break, you’re out of the game, and once 
you’re out of the game, it’s hard to get 
back in the game,” she said.

Of course, the problem is engrained 
far before this stage. Gender 
stereotyping has a lot to answer for, 
says 3D visualisation pro Anita Brown: 

“The gender gap in the 3D/
architectural visualisation 
industry is huge. I feel that 
lack of information or 

knowledge of this type of industry 
among female students is a big factor. 
Increasing awareness of 3D visualisation 
as a rewarding STEM-orientated  
[science, technology, engineering and 
maths] career needs to start at school,” 
she explains. 

Anita is a STEM ambassador and 
dedicated to encouraging more 
females to consider 3D visualisation as 
a career choice. But it’s not just within 
the education system that gender 
stereotyping remains an issue. In 
industry, the clichéd idea that women 
are multitasking ‘doers’ continues to 
fuel an imbalance in the breakdown 
of tasks, with many women still being 
assigned admin roles or ‘care-giver’ 
management positions – particularly 
within film. 
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BRENDA CHAPMAN
Story artist, writer and 
director
brenda-chapman.com

“There’s a lot of talk 
about women, and 
spotlights on the few 
women that are in 
prominent creative/
technical positions, 
but unfortunately the 
percentage of women 
is still appallingly low. 
I think it’s becoming a 
civil rights issue.
However, more 
women are coming 
into the industry. We 
just need to guide 
them in the directions 
of all aspects of the 
industry, not just one 
or two. They need 
encouragement to 
go for what they 
really feel passionate 
about – not to just go 
for what other people 
push them towards 
out of their own 
prejudices, whether 
intentional or  
through misguided 
good intentions.”

WILL COHEN
CEO and executive 
producer, Milk VFX
milk-vfx.com

“On our studio 
floor, there are more 
women coming 
through than 10 
years ago. And our 
Cardiff office (of five) 
is entirely female! 
But there is still a 
gender gap in the 
industry and the ratio 
of men to women 
is not anywhere 
near balanced. It’s 
probably around 
seven to one on 
our artist floor.
Schools, colleges 
and workplaces 
should ensure they 
always encourage 
women to have the 
courage to carve out 
the path they want. 
And I would suggest 
Women in Film is a 
great organisation 
to join. You’ll meet 
women and men who 
will mentor and offer 
great advice.”

ANITA BROWN
3D visualisation
anitabrowndesign 
studio.com

“From my experience, 
females in the 3D 
visualisation industry 
are much more 
interiors focused, 
with men being much 
more architectural/
automotive/character 
focused. I’ve yet 
to see a male 3D 
visualiser provide a 
photo-real scene of 
a wedding reception. 
3D visualisation is a 
marriage of creativity 
with technicality, and 
males and females can 
bring very different 
approaches to the 
wide range of avenues 
in this field – and 
enrich it. My advice for 
making it? Be sociable, 
join online forums and 
groups, take part in 
discussions and offer 
advice. Get your work 
out there – whether 
it’s a blog or niche 
specific publications.”

INDUSTRY INSIDERS 
Thoughts & opinions from the experts

“It’s evolved over the years, but 
when I started most women 
were delegated to the ‘follow 
up’ jobs, such as the clean-up 

department in traditional animation,” 
reflects director Brenda Chapman, who’s 
talked openly about being hired for her 
first animation job in 1987 because 
Disney Animation didn’t have any 
females in creative positions. “Now they 
still follow, in that it’s rare they’re given 
the lead position in some departments. 
Women are usually more utilised in the 
art departments – the looks of films. It’s 
great strong, female artists are designing 
many of these films. I just wish I saw more 
leads in the technical, story, animation 
and other creative departments.”

In 1998 Brenda became the first 
woman to direct an animated feature 
from a major studio – DreamWorks 
Animation’s The Prince of Egypt – and 
later became the first woman to win 
an Academy Award for best animated 
feature, for her work on Disney Pixar’s 
film, Brave. She recalls meeting 
resistance in the past when trying 

to staff her crews with a more equal 
gender balance, and confirms women 
are often encouraged to pursue certain 
parts of the industry at school. “Young 
women from CalArts have been quoted 
as saying they were encouraged to go 
for visual development, while the guys 
were encouraged to go into story and 
animation. They feel that they’re being 
pigeonholed into doing the ‘pretty 
colour’ work.” 

So what can we do to close the gender 
gap in 2016? One aspect to encourage 
more women into the industry – and into 
the roles they’re passionate about – is the 
presence of more female mentors and 
role models, suggests Anita. 

Will Cohen, CEO and executive 
producer at Milk VFX, agrees: 

“It would be great if there were 
more examples of ‘big sister’ 
mentorship type relationships 
among women, in a way I see 

more regularly among men.” 

He believes the gender gap in VFX is 
slowly decreasing, but still exists, as does 
some inequality in salaries. “Sadly, the 
unequal gender balance is endemic in 
our society and a very deep-rooted issue. 
Generally speaking in my experience, for 
example, women don’t come forward as 
regularly as men to ask for a pay rise.”

Sony’s Tara Saunders echoed the 
point during Escape Studios’ webinar. 
“I don’t think women are as forward in 
terms of their own skillsets and selling 
themselves.” Adding that women are 
often more humble than men on their 
CVs. “Something I’d encourage women 
to do is to open a job description, and 
if you find it interesting, you should 
be applying and selling yourself into 
that role, rather than thinking you can’t 
because you haven’t ticked all 11 boxes.”

Responsibility for a better gender 
balance also lies with employers. At Milk 
VFX, the studio strives for equality in 
terms of roles and pay. “Who’s best for 
the job? It’s about talent first of course, 
but if two people were equally good we 
would likely choose the women in the 

interests of a balance,” says Will, adding 
that there are more women on Milk’s 
studio floor than 10 years ago, but there 
is still room for improvement.

As HBO’s vice president of digital 
production services, Barbara Ford 
Grant has commented previously that 
readdressing the gender balance 
might help ease the wider strains of the 
tumultuous VFX industry. “Having more 
women in positions of leadership, in 
positions of production and technology, 
can perhaps help reshape the nature 
of this business by exerting greater 
influence over choices made.”  

Ultimately, opportunities are there for 
the taking. Successful women in CG – like 
successful men – are those who can spot 
job openings and confidently pursue 
them. “Making it as a female in CG is 
no different to any other profession,” 
says Anita. “Once you’re able to prove 
your skill and talent on a visual level, 
there’s no reason why a female can’t be 

This impressive fox 
ring was created by 
senior character artist 
Sze Jones who believes 
there are plenty of 
opportunities for 
talented women in CG

as successful as her male counterpart. 
It’s about being focused, dedicated and 
driven. And never giving up.”

Senior character artist Sze Jones 
agrees. She’s been creating iconic 
heroine characters for the last 18 years, 
and seen more women entering the 
games and film industries. “The gap is 
definitely getting smaller. Companies 
are actively opening their doors to 
females with adequate skills and 
exceptional portfolios. Although there 
are many challenging tasks and niches 
in CG production, women have equal 
opportunities to enter the field,” she says. 

“The obstacles are possessing 
the technical knowledge and 
artistic skills. I believe anyone 
who pursues the field with 

passion and determination will be able to 
enter it. It takes time, focus, persistence 
and endless practise to make it.”

FYI
To see the Women in Industry webinar 
sign up at  www.bit.ly/3dw-escape

Something I’d encourage women to do is to open a job

description, and if you find it interesting, you should be 

applying and selling yourself into that role

Tara Saunders, Sony
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MAKE MORE OF YOUR MODELS
We’re partnering with Creative Market to offer a series of free 
downloads, continuing with Graphics834’s quadcopter drone

W ant a model of a cool-
looking drone, that’s highly 
detailed yet generic enough 

to personalise? Then this quadcopter 
drone is what you need. It’s the work  
of Graphics834, aka 3D artist Adrian 
Wise, whose work can be seen on 
Creative Market.

A platform for digital design content 
from independent creatives around 
the world, Creative Market recently 
launched a 3D art section. It’s a great 
place to sell your content, says Adrian. 

“One of the ways it differs 
from other sites,” he explains, 
“is they assess you as an 
artist first. If your work meets 

quality standards you are approved, 
and once that happens, all the work 
you submit immediately goes on sale: 
there’s no inspection queue, waiting for 
approval, or checking. Of course the 
revenue you generate is also a factor, 
and a commission rate of 70 per cent is 
hard to turn down!”

Adrian’s portfolio of images generally 
consists of ‘things’, images of things, 
or characters using things. “Photoreal 
rendering is only half the battle,” he 
says. “With my background in product 
design, my models are built with an 
understanding of real-world products.” 
That means maintaining a library of 
asset elements, including screws, nuts, 
bolts, washers, fasteners, switches, 

knobs, dials, rubber feet, wheels, widgets, grommets and 
more. “The devil is in the detail, and that is what I bring 
to my 3D assets,” he stresses. “My products include the 
details you find in real things, from split lines where it  
goes together, to the surface finish you find on moulded 
plastic products.”

He offers this advice to anyone wishing to sell their 
work on Creative Market. “Customers get to see the raw 
ingredients, so you need to make sure your model is ready 
to be used. For example, name it, not Box01, Box02: put it 
at 0,0,0 so they don’t have to look for it when they open it.” 

“Also, and most importantly, make sure you show it at 
its best: take the time to establish a render setup that will 
portray your work for the quality it is. Personally I have a 

3ds Max template set up just for Creative Market. This 
way all my settings are consistent, my products have a 
consistent look, you can identify a Graphics834 asset, and 
it makes it quick and easy for me and the customers to get 
a consistent quality image.”

We’ve partnered with CreativeMarket.com to make 
Graphics834’s quadcopter drone model available for 
readers to download – absolutely free! Just visit our 
online Vault at www.creativebloq.com/vault/3dw204 and 
download. Note that this pack is free for personal use only: 
to purchase for commercial use, visit www.bit.ly/204-drone.

FYI
To see more of Graphics834’s work go to  
www.creativemarket.com/graphics834 

ADRIAN WISE
Adrian is owner of 

Graphics834, which 
undertakes custom  

asset creation for 
corporate clients, web 

graphics and video, and  
design visualisation.

www.creativemarket.
com/graphics834

ELECTRIC MOTOR
Ideal for use in 
industrial scenes, this 
electric motor was 
built in 3ds Max 2015 
with Open SubDiv for 
LOD control. get it at: 
www.bit.ly/3d-motor.

COUNTER BALANCE 
FORK LIFT TRUCK
This detailed forklift 
truck model is perfect 
for a warehouse or 
construction site 
scene. It’s rigged 
for animation with 
controllers for vehicle 
placement, mast lift 
and tilt. Download it: 
www.bit.ly/3d-fork.

INDUSTRIAL ROBOT 
ARM [RIGGED]
Ideal for industrial 
and manufacturing 
scenes this robot 
arm is built in 3ds 
Max 2015 with 
Open SubDiv for 
LOD control. It’s fully 
rigged for articulation 
with control objects 
for easier animation. 
Download it here: 
www.bit.ly/3d-robot.

RISE OF THE 
MACHINES

There’s more where 
that came from…

CREATIVE MARKET

Establish a render setup that will portray your

work for the quality it is… I have a 3ds Max  

template set up just for Creative Market    

Graphics834’s detailed 
models are built with 
an understanding of 
real-world products

COMMUNITY
Creative Market
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We all dream of setting up 
our own company, one that 
focuses only on the kind of 

projects we love. But producer Paul 
Laikin and animation directors Jason 
Jameson and James Hall didn’t just 
dream about it – they actually did it, 
teaming up to found the independent 
production company and animation 
studio Unanico in 2009.

“We grew out of a company 
Jason had previously run 
called Model Robot,” 
explains Paul. “They’d been 

working on music videos, ads and 
short films. But we wanted to move 
more towards production work on TV 
series and films and away from the 
commercial work.”

Things progressed quickly, with  
Gary Kurtz, the producer of Star Wars 
and The Empire Strikes Back, joining  
in 2011. “That came about in the 
context of developing an animation 
feature film with a Chinese co-
production partner,” explains Paul, 
“and so we also set up an office in 
Shanghai to work on Chinese co-
production projects.”

Since then, Unanico has gone from 
strength to strength, and international 

co-production has become part of its DNA. “Everything we 
do is pretty much co-produced with a person or company 
from another country, and we love that,” explains Paul. 
“Creatively, you get some really interesting combinations. 
And in practical terms, as long as it doesn’t involve too 
many countries, you can do quite well in terms of financing. 
So looking for likeminded open co-production partners is 
something we’re keen on pursuing more and more.”

A good example is One Night in Hell, a groundbreaking 
animation about a skeleton’s journey into Hell. “It started 

off as a short film that we made in partnership with Duck 
Productions, Queen guitarist’s Brian May’s production 
company,” says Paul. “Now we’re developing a full feature 
film out of it, with partners including Mackinnon & Saunders 
(the puppet studio behind Corpse Bride and Fantastic Mr 
Fox); and Media Participations (a media group based in 
Paris and Brussels).” 

Unanico isn’t just about TV and movies, though; it’s also 
developed an intriguing sideline in casual mobile games, 
such as the free iOS game Totter, which The Sun  
newspaper called ‘The most addictive game ever.’ 

COLLABORATION WITHOUT BORDERS
Independent London studio Unanico tells Tom May how international 
co-production has been the key to its success

LOCATION 
 London and 

Shanghai

TEAM SIZE 
Around 10; varies  

by project
  

KNOWN FOR
3D and 2D computer 

and hand-drawn 
animation; live 

action/animation 
film, TV and branded 

entertainment content; 
games, smartphone 
applications, books, 

toys and other 
merchandising/

licensing opportunities
 

MANAGING 
DIRECTOR
Paul Laikin

STUDIO
STATISTICS

PAUL LAIKIN
Paul is co-founder and 

managing director at 
Unanico Group. 

www.unanico.com

STUDIO PROFILE

Everything we do is pretty much 

co-produced with a person or company

from another country, and we love that 
Paul Laikin, co-founder and director, Unanico
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“You just have to balance this character on a rock,” 
explains animation director Jason Jameson. “It’s 
designed as a very simple, catchy game for people 
to play with just one hand. We built it pretty 

quickly using the Unity game engine,” he adds. “It’s 3D but 
made in a 2D way – they’re all drawings made in Photoshop 
or hand-painted, then animated within Unity.” Following its 
success, Unanico has since released Totter Mini, an 
expanded version of the game for kids.

Unanico has a core team of about 10, but the number of 
artists working there fluctuates wildly, says Jason. “It goes 
up and down depending on the project – it’s quite fluid,” he 
explains. “We tend to use freelancers we know, but look at 
new artists all the time and take a lot of interns.” How do they 
pick them? “I’ll mainly go on portfolios and their showreels – 
I tend to not bother too much about CVs.”

Artist Anna Martorano Oliver started as an intern at 
Unanico two years ago, and has since gone full-time. She 
works with software including 3ds Max, Maya, 3D Coat, 
Photoshop, After Effects and Unity, and says she loves the 
friendly atmosphere.

“Working at Unanico has been a great experience,” 
she says. “My working space is very cosy: there’s a 
big island of tables in the middle of the room, 
which makes communication easy. The team is very 

international, and it’s great to be in contact with different 
cultures: there’s something new to learn every day. I work hard 
and under great direction, but feel free to share my ideas on 
new projects, which makes the relationship very relaxed.”

FYI
To learn more about Unanico and see examples of their  
work, visit www.unanico.com

ENGLISH HEDGEROW
Created by Unanico with Andrew Tanner Design, the English Hedgerow 
app brings a Royal Winton plate to life with augmented reality. Point 

your mobile device camera at the plate and the story develops on your 
screen, changing and interacting as you move it around the design.

STUDIO
PORTFOLIO

JASON JAMESON
Jason is co-founder and 

animation director at 
Unanico Group. 

www.unanico.com

ANNA MARTORANO 
OLIVER

Anna has been working 
as a 3D artist at Unanico 
for more than two years. 

www.unanico.com

ONE NIGHT IN HELL
One Night in Hell is a spectacular animation that brings to digital life 
the lost art of 19th-century stereo cards. The short and accompanying 
app were created by Unanico and Queen’s legendary guitarist Brian 
May. You can read our exclusive report on making the animation on 

Creative Bloq: www.bit.ly/3dw-brian-may

TOTTER
Totter is a cyber-balancing iOS game built by Unanico using the Unity 

game engine. Free to download from the App Store, it combines 
simple gameplay with classic, hand-drawn character design, graphics 

and animation to create a truly addictive experience.

OFFICE BRIEFING
Unanico Group is an independent producer of audiovisual content and associated products 
based in London and Shanghai. Founded in 2009 by producer Paul Laikin and animation 
directors Jason Jameson and James Hall, its work has appeared in numerous festivals and 
broadcast on Sky, MTV, Nickelodeon, BBC, Channel 4, Channel 5, Cartoon Network and other 
channels around the world. Winner of the Cartoon Forum 2011, for WoodLand, and the Jury 
Grand Prix Award at the Shanghai Television Festival 2011, for London A to Z, Unanico was 
also nominated for the Writers Guild of America Screenplay Award 2014 for No Place on 
Earth and the Design Museum (London) Design of the Year 2013 for English Hedgerow.
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UNDERCOVER CGI
Shade VFX’s Bryan Godwin reveals how undetectable 
effects are shaping up Hell’s Kitchen in Jessica Jones

A ccording to Shade VFX CEO Bryan Godwin, 
“Jessica Jones is one of the most ‘real’ superhero 
stories ever told.” His team have been responsible 

for bringing the super powered sleuth to life in 
Marvel and Netflix’s ongoing series, and their 
supporting effects aid the gritty storytelling. 
“We are making the scenes more action 

packed, more dangerous, more intense, without big 
science fiction moments. We are trying to share the real 
danger and bring the audience into Hell’s Kitchen.”

Speak of the devil
The team were in good stead following their work on 
Netflix’s Daredevil, for which they received an Emmy 
nomination: “Working on Daredevil is a lot like working 
on a 13-hour movie, more so than 13 one-hour episodes. 
The bar is very high, we definitely had to bring our 
A-game to everything. Netflix requires everything to be 
delivered at 4K, which is nearly twice the resolution we 
provide to feature films,“ Bryan explains. This presented 
a lot of challenges, “We have to do a lot more stuff with 

3D, CG rather than relying on 2D. We 
also learned how to work very quickly 
and efficiently because of Daredevil’s 
challenging schedule. The first season 
the show had over 1,000 visual effects 
shots and was completed in about six 
months, so it was fast. I think we  
were armed and ready to jump into 
Jessica Jones after the first season  
of Daredevil.”

Masked mechanics
“For this project we were challenged 
more than ever – to be the invisible hand 
of VFX and do our very best for this to 
feel like a ‘no CGI’ show,” Bryan reveals. 
“Our ultimate goal is for the viewer to 
not even realise that any visual effects 
were used in what they just watched. A 
supporting effect does not have to be 
apparent to be very effective.”

However, there were over 600 effect 
shots throughout the series – everything 
from complex fire simulations to digital 
stunt doubles, creatures, gore, and 
set extensions. “It was a surprisingly 
complex show.”

Jessica Jones was slightly less 
intensive than Daredevil in terms of 
visual effects, “but the idea was very 
similar in that our work was meant to 
be invisible,” Bryan continues. Just like 
Daredevil, “it was a fast schedule that 
moved rapidly and we had to be flexible 
with changes and new ideas throughout. 
We’re incredibly proud of how much 
work was done on JJ, and even more 
proud how little of it can be seen.”

FYI
Jessica Jones is streaming on Netflix  
netflix.com/gb/title/80002311 

BRYAN GODWIN
Bryan is CEO of Shade 
VFX who have worked 

on True Detective, 
Daredevil (for which they 

were nominated for an 
Emmy) and Jessica Jones. 
They are currently part of 

the special effects team 
on Batman vs Superman. 

www.shadevfx.com

CIRQUE DU SERKIS
The Star Wars actor 
and mocap veteran 
is backing a unique 
training course for a 
new generation of 
creative technicians to 
work in performance 
capture. The 10-week 
course will be run by 
the National Film and 
Television School in 
partnership with The 
Imaginarium Studios 
– the performance 
capture studio and 
production company 
co-founded by 
Andy Serkis, a.k.a. 
Lord Snoke in the 
forthcoming Star Wars: 
Episode VII – The  
Force Awakens.

Andy says: 
“We’re thrilled to 
be partnering with 
the NFTS to deliver a 
unique course that  
will train a new 
generation of creative 
technicians to work in  
performance capture.”

CAPTURING TALENT
The course will start 
in February 2016, 
with applications 
closing on the 11th 
January. Graduates 
will produce a fully-
realised performance 
capture sequence to be 
shown at an industry 
screening. There will 
also be a guaranteed 
paid job for one 
graduate at the end  
of each course.

Tony Orsten, CEO 
of The Imaginarium 
Studios explains: 
“Working with the 
NFTS to inspire and 
educate the next 
generation of creatives/ 
technicians in the 
performance capture 
arena is clearly vitally 
important to continue 
the UK’s stellar journey 
in the VFX industry.”
For more details visit 
www.bit.ly/3dw-nfts

NEW TECH  
TRAINING

Andy Serkis paves 
the way for new 

mocap performers

INDUSTRY INTERVIEW

Working on 
Daredevil prepared 

the team for jumping 
into Jessica Jones

Shade VFX were challenged to create 
superhumans in a gritty, realistic show. 

Jessica Jones’ boyfriend, Luke Cage, 
has impermeable skin and remains 

untouched when set alight
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TRIAL BY FIRE
Alan Bell explains why the fast-moving sequences of The Hunger 
Games: Mockingjay – Part 2 posed such a challenge

To edit one blockbuster movie 
is tough enough. But veteran 
editor Alan Bell faced an even 

tougher task bringing the Hunger 
Games quadrilogy to its conclusion. 

“Since Mockingjay Part 1 
and 2 were shot at once, 
we were constantly flipping 
back and forth between 

the movies while we were shooting 
them,” he explains. “For instance, one 
day I could be cutting the lizard mutt 
battle sequence, to make sure we had 
everything we need for Part 2, and then 
the next I’d be working on Katniss 
meeting Coin for the first time in Part 1. 
Keeping the stories straight and 
knowing where all the pieces fit was key.”

And there was another novelty for Alan on the Mockingjay 
films: for the first time he was able to work on set in his 
own trailer. “It was pretty cool as it was set up with a 
projector and I had a 5.1 sound system, as well as all the 
software tools I am used to, such as Blackmagic Fusion 
Studio, Cinema 4D and Avid Media Composer,” he 
enthuses. “Working in the trailer on set meant that I could 
get input from the director frequently, and any time I had 
a question about blocking I was always a short walk away 
from the answer.”

Working on the fly 
One of the most challenging sequences he worked on 
was the lizard mutt sequence, where Katniss and her 
unit have to fight the Capitol’s engineered weapons 
while trapped underground. “There was a tremendous 
amount of footage to sift through and sort out,” says 
Alan. “Each character had their own battles going on 
simultaneously, which meant as one set of people fought 
in the foreground you would see another group active in 
the background.”

“As an editor I must play with time during fast moving 
sequences where everything seems to be happening at 
once. I often have to show each segment as a separate 
moment in order to build tension and allow the audience 
to understand and feel the excitement of the scene. 
By using Fusion Studio, I was able to manipulate the 
background action in order to make it all flow and avoid 
repeating moments.”

This meant that Alan often had to create clean plates 
on the fly and paint out characters quickly in order to 
make the scene work. Muzzle flashes also needed to be 
added, along with explosions and fire. “Once we turned 
over the sequence to our VFX department, we started 
collaborating on the mutt animation and little by little, the 
human stand in mutt characters would be eliminated from 
the scene. This scene itself took close to eight months to 
finish, from the time I had a first cut to its completion.”

FYI
For more information about Mockingjay – Part 2, visit 
the official website at www.thehungergames.movie

ALAN BELL
Alan is known for his 
work on The Hunger 

Games: Catching Fire, 
The Green Mile and 

(500) Days of Summer.
www.imdb.com/name/

nm0068008

Next-gen rendering 
tool Clarisse was 
put to good use on 
The Hunger Games: 
Mockingjay – Part 2, 
says Eric Vezinet, 
rendering supervisor 
at Double Negative. 
“We had a shot with 
more than 100,000 
actors and props 
on top of the entire 
city environment, 
and no geometry 
LOD for background 
buildings,” he 
explains. “We had to 
deal with brute force, 
huge Alembic caches 
loaded into Clarisse 
[but] the nice surprise 
was that once loaded 
and live in the project, 
Clarisse was able to 
very easily handle the 
amount of geo. It was 
pretty easy for the 
artist to navigate into 
the entire city, replace 
their lights, do their 
layouts and so forth.”

Since Clarisse’s 3D 
view is powered by its 
rendering engine, you 
can work interactively 
on actual scenes 
without the need for 
using proxies.

Clarisse was still 
very interactive, 
Eric explains, even 
with more than 
220 billion polys in 
this environment. 
“It was rather easy 
to navigate into 
both the raytraced 
views, and do proper 
artistic work on the 
crowd, like moving 
and removing 
actors, quickly 
testing different 
look alternates – all 
interactively, with the 
real CG around.”

RENDERING 
TOOL

Clarisse helped 
Double Negative 

build massive 
environments

VFX INTERVIEW

As an editor I must play with time during 

fast moving sequences where everything 

seems to be happening at once 

Working on two Hunger 
Games films simultaneously 
stretched Alan Bell’s editing 

smarts to the limits

The Mockingjay films were 
the first time Alan was able 
to work on set in his own 
trailer, making it easier to 
get input from the director
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HOW A FAN PROJECT  
LEAD TO AN ILM CAREER
Posting a personal project online led to Joe Grundfast getting 
hired by Marvel. He tells Tom May how it all came about…

Many good things can come out 
of personal side projects, but 
getting hired to work for  

Marvel isn’t normally one of them.  
Yet that’s exactly what happened to 
Joe Grundfast.

It was 2014, and he’d been 
freelancing as a generalist for nearly 
three years, but wanted to get back  
into character design work.  

JOE GRUNDFAST
Joe is a freelance ZBrush 
artist and CG generalist 

based in New York 
City. He has previously 

worked at The Artery VFX, 
Perception NYC and  

3rd Strand LLC.
www.bit.ly/joe-grundfast

ARTIST INTERVIEW

I had no idea it would energise people 

the way it did. The reaction of the CG 

community was beyond gratifying

“Inspired by the first Iron 
Man film, I wanted to 
show that I could handle 
Hollywood film design by 

doing a concept of War Machine in 
the hope of working on a sequel some 
day,” he explains.

He began laying everything out in 3ds 
Max – software that was still new to him. 
“I learned the latest tools of the time 
in ZBrush like DynaMesh, ZRemesher, 
UV Master, and Decimation Master to 
complete the design and turn all of the 
base geometry into sculptable surfaces. 
My mentor, Yariv Newman, consulted 
with other industry professionals on how 
best to present the model, which took 
me from V-Ray renders in Max and back 

COMMUNITY
Artist interview
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to ZBrush where I finalised the animation 
with the BPR movie renderer and a dash 
of After Effects. The whole project, start 
to finish, was an education in CG.”

He was keen to share the lessons 
he’d learned with others, so he posted 
it to the web – along with a tutorial and 
the full 3D model. And the internet 
went crazy for it.

“I was floored by the response,” 
recalls Joe. “I had no idea it would 
energise people the way it did. The 
reaction of the CG community was 
beyond gratifying, and I owe a debt to 
everyone who has shown support and 
enthusiasm for my stuff.”

War Machine won a coveted Top Row 
on ZBrush Central and got exposure 

on CG blogs, Vimeo groups, and other 
sites (to this day, the model itself has 
been downloaded over 9,000 times).  

Then in early 2015, something else 
happened… Perception VFX in New 
York was scouting local ZBrush artists 
in preparation for a pitch they were 
making to Marvel for the Avengers 2: 
Age of Ultron main-on-end titles. “This 
particular pitch featured an epic marble 
war monument to the Avengers,” says 
Joe, “and they came across my War 
Machine animation, which was very 
similar in spirit to their vision of graceful 
camera moves sweeping across 
imposing, static Marvel characters.”

The company first hired Joe to work 
on a separate spot, and he started to 

get a feel for the studio. “Then  
when Marvel called with approval of  
the monument pitch, I was hired,”  
he explains. 

Working alongside ZBrush artist 
Casey Rueter, Joe went on to sculpt 
and help design the Avengers’ war 
memorial in ZBrush. “I’ll never forget 
the first day of work,” he reminisces.  
“My anticipation grew as the Hulk  
Maya file loaded into the viewport  
and I had a moment of pure  
geekdom euphoria, thinking ‘Holy  
shit, I did it! This is actually happening; 
I’m about to sculpt the Incredible Hulk 
for Marvel!’”

FYI
See more of Joe’s work at  
www.vimeo.com/user3828292 

When Joe posted 
his War Machine 

model online, it set 
the internet alight

FREE!
FIND THE MODEL 

IN THIS ISSUE’S 

ONLINE VAULT
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THE PROS
“Fan art is a less 
risky way to scratch 
the inspiration 
itch,” says Joe. “The 
coolness of the idea 
is built automatically 
into what you’re 
doing, because your 
odds of success are 
better with ideas that 
have already passed 
market testing.”

THE CONS
“With fan art, you 
can’t claim complete 
ownership over your 
work,” cautions Joe. 
“Also, fan art does 
not really challenge 
the viewer – unless 
you really warp 
and change the 
subject. That’s the 
tightrope you walk 
with a copyrighted 
character.”

THE BEST FAN ART
The best fan art does 
something no one 
else has done before, 
Joe believes. “I was 
fortunate in that no 
cinematic version of 
War Machine has 
done justice to the 
classic mini-gun/
missile launcher 
configuration from 
the comics,” he adds.

FAN ART 
TIPS

Joe’s advice on  
fan projects



W ith all the characters to 
choose from in the Star Wars 
saga, selecting the aim-

challenged stormtroopers is a left-field 
choice, but artist Juan Martin Garcia 
Forn has his reasons. 

“Stormtroopers are formidably 
introduced in A New Hope, 
but progressively start losing 
credibility as they’re blasted 

by our heroes, and stoned by a pack of 
ewoks in the last film. People nowadays 
make jokes about their aiming skills, so 
it came to mind that The Force Awakens 
will remind the world how fearless and 
precise these troopers are intended to 
be,” Juan explains.

“I tried to merge my favourite films 
with a sport I love: paintball – hence the 
action pose, running through blasters, 
and shooting from the sights. But  
really the main reason is that my  
lovely girlfriend gifted me an  
awesome thermo flask of the First 
Order’s stormtrooper.”

Star Wars remains an inspiration for 
the flask-loving artist. Juan says the film 
franchise is still such a big influence on 
art because of the people involved in 
making the series what it is. “People 
like Ralph McQuarrie, George Lucas, 
Irvin Kershner, and everyone else 
involved in the making of Star Wars 
have brought us a new form of culture, 
that will never be forgotten. I think that 
from design to storytelling, Star Wars is 
there to tell us artists that our dreams 
can come true, with a little imagination 
and a lot of hard work – to not be 
afraid of our ideas because our art can 
influence history itself.”

For this project, Juan reveals planning 
the composition ahead of beginning 
the modelling and rendering proved 
the most challenging aspect, partly 
because the paintball-influenced pose 
restricted how he needed to work. 
“Since I had a very clear idea of how 
the final image should look, the lighting 
and camera angles had to be planned 
before the execution. Everything was 

MODELLING A FORCE 
AWAKENS STORMTROOPER
Juan Martin Garcia Forn shares insights into how he 
modelled the iconic Star Wars character

ARTIST PROFILE
Juan works as a 

design and marketing 
supervisor for a 

women’s footwear 
company in Mexico 

called Mirella, and also 
takes on projects as a 

freelance artist.
www.behance.net/

Juan_Martin

1 MODEL FROM REFERENCE
Finding references at the time of modelling was slightly difficult. I had to 

mostly rely on photos from toys, and armour from conventions. The first part 
I modelled was the helmet. It was the trickiest because I wanted it to have 
as clean a topology as possible, hence why I used Maya. I started with the 
nose part as it gave me a nice spatial guide for the rest of the helmet. Inner 
extrusions were especially helpful to maintain proper edge flow.

IN FOCUS

SOFTWARE
ZBrush, Maya, 

KeyShot 

COUNTRY 
Mexico 

PRODUCTION TIME
22 hours

VITAL
STATISTICS

then pretty easy thanks to KeyShot’s 
very friendly interface.”

For once, the Empire/The First 
Order’s biggest joke appears as the 
heroic fighting force that once blitzed 
the galaxy far, far away. Now, keep 
reading to gain some insights into 
Juan’s creative process… 

FYI
For all the assets you need go to 
creativebloq.com/vault/3dw204
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2 TOPOLOGY IN ZBRUSH
For bigger armour parts, 

such as the chest area, I used the 
topology tools within ZBrush. I 
picked a base mesh for guidance: 
Nick Zuccarello’s human male 
from ZBrush tools. I created a 
ZSphere and bound the mesh to 
the ZSphere for rigging. The Edit 
Topology function was used to 
draw the topology over the base 
mesh, and once I was happy I 
created an adaptive skin.
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3 EDGE FLOW
I took a lot of care on the edge flow as 

it was key for keeping the armour smooth 
and even. Also, if needed, it makes it useful 
for rigging and different types of animation. 
Only one side of the armour from the limbs 
was modelled; it was then mirrored to quickly 
get the other side, since it’s symmetrical.

5 ZBRUSH FOR DETAIL
Alpha images were 

created in Photoshop to 
make it easier to import 
into ZBrush, where I could 
begin adding extra detail 
to the armour. I used the 
Standard brush set on 
negative, with DragRect 
stroke for more precision.

4 MODELLING  
THE GUN

I chose Maya to model the rifle 
because it has a very specific 
design, and the program’s 
orthographic views and easy 
polygon modelling system gave 
me a very satisfactory result. 
The final model was then 
imported to ZBrush so that I 
could add small details, such as 
screws with an IMM brush. It 
has 42 separate pieces in total.
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6 CHARACTER POSING
The character was posed 

in ZBrush without the need 
for a rig, simply by using the 
Transpose Master plug-in. Using 
this plug-in enabled me to pose 
all the subdivided tools in their 
lowest division, without losing 
any details in the final pose.

7 USE KEYSHOT  
FOR RENDERING

Rendering in KeyShot is very easy and 
intuitive, I just had to choose the materials 
from the library and do a few tweaks. 
Render passes helped me build a stronger, 
more custom image. I did a raw render, an 
ambient occlusion pass, a rim light pass, a 
second rim light pass to be used as the 
light emitted by the blasters, and a clown 
pass to generate a mask in Photoshop.

8 COMPOSITE THE FINAL IMAGE  
Compositing and final effects were 

done in Photoshop with matte painting and 
hand-painted details. The most important 
thing was composition; for the image to 
have a lot of action, I based composition 
upon triangles and colour gradients.
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Your software queries solved 
by our CG experts

Q&A
ARTISTEXPERT PANEL

Eva Ng
Eva is a London-based 
freelance 3D artist with 
an emphasis on lighting 

and compositing. She loves to create 
compelling imagery to entertain.  
www.eva-ng.com

GET IN TOUCH

EMAIL YOUR QUESTIONS TO
ian.dean@futurenet.com

Phoenix FD is a great 
tool for creating fluid 
simulations, such as fire

Francesca Forzoni
A 3D artist/visualiser in 
London, Frankie recently 
moved from post-

production to branding and packaging 
and currently works at Design Bridge. 
www.francescaforzoni.com

Rob Redman
Rob runs a 3D animation 
and VFX studio, working 
for clients ranging from 

governments to rock stars. He’s also 
an industry commentator and trainer.
www.pariahstudios.co.uk

Paul Hatton
As the 3D visualisation 
team leader at CADS 
3D, Paul creates models 

and renders, visualisations, animations 
and interactive walkthroughs.
www.cadesignservices.co.uk/3d
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 Paul replies
Phoenix FD is a brilliant 
little tool for creating fluid 
simulations including liquid, 
foam, splashes, fire, smoke 

and explosions. It is readily accessible 
and usable for the average user and is 
relatively quick and straight forward to 
set up. Good results can be achieved 
without needing to tweak a whole load 
of complicated settings, which is good 
for the visualisation community. It’s 
important to note that Phoenix FD  
does provide a whole host of 
customisation though, so if you are 
wanting to create something more 
complicated and customised then  
this is still achievable.

How can I quickly set up a home fire using Phoenix FD?
Tony Jordan, USA

PHOENIX FD

EXPERT TIP
Adjust simulation  
settings on the fly

With the simulation running, you 
can adjust any of the settings 

and see your simulation adjust 
accordingly. This is brilliant for 

fine-tuning what your simulation 
looks like rather than having to 

stop the simulation, adjust  
the settings and  

then resimulate. Thank  
you Chaos Group!

ONE CREATE YOUR SIMULATOR
We need to create a 3D volume in which our 
simulation will take place. This enables us to 
contain what is happening. This volume could 
be the size of the fireplace, or a container 
which will hold water, for example. To do this 
head over to the Create panel and choose the 
Geometry tab. Then select Phoenix FD from 
the drop-down and PHX Simulator.

TWO CREATE SOMETHING TO BURN
We’re creating a fire so we need to create an 
object to burn. This could be the geometry 
that will be visible in your final render, but 
it could also be another object placeholder 
that will be invisible to the camera. In this 
example I created a simple cylindrical log 
using the standard create tools. A cylinder will 
do nicely. Make sure it’s inside the simulator.

THREE LINK STEPS 1 AND 2
We need to connect the simulator with 
the object that we are going to burn. We 
can do this by creating a Phoenix source 
node, which is found in the Helpers 
section. Drag the node into the viewport 
and then go to its modify settings.  
Select Add and then click on your log in 
the viewport.

FOUR RUN THE SIMULATION
Now all there is left to do is to run the 
simulation. Do this by selecting the 
simulation object that you created in step 
1. Then go to its modify settings and ensure 
that the Simulation rollout is open. Locate 
the Start button and press it. You’ll now see 
your log burning! Hit render at any time to 
see your beautiful results.

STEP-BY-STEP CREATE A LOG FIRE 

A few years back I would be relying on  
a complicated setup of bitmaps in  
order to achieve something like a living 
room fire, and it would generally be 
fine for still images, but hugely lacking 
during videos. Phoenix FD changes 
all that. It is even incredibly quick to 
render, which is fantastic! I would highly 
recommend downloading a demo and 
just giving it a try.

It’s also worth noting some of the 
other features so that you can see how 
extensive this piece of software is. When 
generating liquid simulations, you can 
accurately and quickly simulate foam 
and splashes as well. New particles 
are generated at the point where the 
originating liquid would turn into foam 

or a splash. These particles can even be 
shaded with a bespoke shader, which 
will give you even more control over the 
look and feel of your simulation. When 
creating simulations of fire you also get 
the added benefit of smoke particles 
being generated. These can also be 
shaded enabling you to get beautiful 
volumetric smoke. 

One final thing to mention is the 
possibility of previewing your simulation 
on the GPU. It fully simulates lighting and 
diffuse colour shading. The simulation 
can even be saved as .png files for review 
and removes the requirement to render 
the simulations on the CPU. The speed 
of this is obviously dependent on your 
graphics card.
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 Francesca replies
For me, the best way is to create a base mesh 
with Cinema 4D, sculpt in ZBrush and finish off 
back in C4D. To create a base mesh in C4D, you 
can either build text using MoText or import 

vectors from Illustrator. You want to create a rounded base 
shape to your letters here, so extrude and fillet both caps.

Once happy with a base to sculpt onto, bring your text 
into ZBrush. I tend to import and sculpt one letter at a time 
as the meshes can get quite heavy and it’s easier to sculpt 
around the entire letter this way. When bringing my mesh 
into ZBrush I always use the ZRemesher as this creates a 
smooth, clean mesh that allows your sculpting to be clean. 
I also use the Layers function in ZBrush. This works similar 
to Photoshop layers: each layer of sculpting you record, 
you can turn on and off of your model, you can also control 
the depth/height of each layer too. This allows for much 
more control, and if dealing with client feedback, I find 
having layers helps make amends later down the line. 

My go-to brushes for balloon making are Standard, 
Slash and Inflate, within ZBrush. It might take you a couple 
of tries to get this right but you’ll get there! I find Lazy 
Mouse really helps to create smooth slashes across the 
material, and I normally activate Active Symmetry to work 
on both sides of the balloon at the same time.

Once you’re happy with your sculpting in ZBrush, bring 
all your models into C4D. Rotate all of your balloons 
slightly so they look a bit more realistic. Texture and light 
your scene, then finally you can render. You can add strings 
and balloon ties on in Photoshop afterwards.

What’s the best approach to 
creating balloon typography 
for beginners?
Sam Hutchins, Australia

CINEMA 4D
ONE CREATE BASIC SHAPES 
Create base text within Cinema 4D either 
using MoText, or if using vectors imported 
by Illustrator, extrude and add a fillet cap 
to the front and back of each letter. Try to 
get the 3D text as rounded as you can in 
this initial stage, keeping your poly count 
low because we are going to subdivide 
in ZBrush. You’re just aiming for basic 
letter shapes with soft bevelled edges as a 
starting point for sculpting.

TWO CLEAN UP YOUR TOPOLOGY
Export your letter as an .obj from C4D. 
Open ZBrush and under Tool you want to 
‘Import’ your mesh. Once imported, go 
down to Geometry and click ZRemesher, 
which I find cleans up my topology 
nicely. Click Edit Tool to make your object 
editable. I then always go over to my 
Layers, click New and Record. I do this for 
every different part of the sculpting I’m 
working on.

THREE BEGIN SCULPTING
Time to start sculpting. I normally use 
the Standard brush to sculpt the seam 
around each of the letters. Then my go-to 
brush for balloon sculpting is Slash, to 
create the stretch marks and creases 
on the balloons themselves. Active 
Symmetry is great here to let you sculpt 
into the front and back of the letters at 
the same time. Don’t forget to up your 
subdivisions for finer detailing. 

FOUR FINISHING TOUCHES
Once I am happy with your balloon letter, 
I will normally try out a Chrome texture 
within ZBrush, in order to get an idea of 
what the highlights will look like and if 
there’s any part that is missing detail or 
needs smoothing out. You can export  
your letter as an .obj and import it back 
into C4D. I would then composite all of 
my letters together, and texture, light and 
render in C4D.

STEP-BY-STEP

ARTIST Q&A

Import and sculpt one letter at a time as 

the meshes can get quite heavy and it’s 

easier to sculpt around the entire letter 

EXPERT TIP
Keep it simple

Remember the balloons are inflated 
and should still look inflated after 

you’ve sculpted all your creases 
across them. Grab the Inflate tool 

in ZBrush, make the size of it bigger 
than your model, and just sweep 

over your model. This inflation will 
just help curve your model  
around the slashes you’ve  

sculpted, making it  
look more realistic.

CREATE BALLOON TYPOGRAPHY
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 Rob replies
There are a few ways of dealing 
with this and they really depend 
on how close your camera will 
be to the wet patches. You 

could use some displacement to add 
shallow recesses in the wood and  
then have a second ‘water’ plane that 
would show in the recesses to act as 
puddles, but that might be overkill for a 
lot of situations.

I prefer to take advantage of Maxwell’s 
excellent Material Editor, which will allow 
us to add layers of water all within the 
one material and one piece of geometry. 
Seeing as layers in Maxwell materials are 
essentially nested new materials, you 
can control everything wood completely 
separate from the water and use a 
simple mask and/or weight figure to 

control where the water will be placed.
This is great as it means you can simply 
adjust the maps when needed without 
the hassle of rebuilding them for other 
elements of the materials.

To get started you’ll need to work on 
the wood material first and these are 
usually pretty simple to build. You can 

How do you make a wet puddle on wood material in Maxwell? 
Lizzie Rose, UK

MAXWELL RENDER 

EXPERT TIP
Keep it procedural

You could actually do this 
without any painting of maps if 

you want to stay procedural. But 
to do so you’ll need to open up 
your Material Editor, switch to 
the MXED and add one of the 
procedural noises as a mask, 

adjusting the seed until  
you get a look you like.

This technique can be 
used for many things, not 
just puddles on the road

go the whole hog and add subsurface 
scattering, but in most cases you won’t 
need to. A simple diffuse map for the 0 
degrees and 90 degrees slots will suffice, 
usually along with a Bump or Normal map 
for surface texture. That should make for 
a reasonable starting point, or use the 
Material Editor’s link to the MXM library 
and search for one that fits your needs.

Next up, add a new layer to the top 
of the stack and rename it ‘water.’ Set 
this up as you would if you were making 

a single layered water material. Once 
you are happy, you can head over to 
your image editor and paint a greyscale 
map to define the wet areas. It doesn’t 
matter if you use white or black for the 
wet parts as Maxwell lets you invert. Save 
the map and back in Maxwell load it into 
the mask/alpha slot of the layer’s weight 
section and you are good to go. But don’t 
forget: this same technique works for 
many things, like moss on stone, or labels 
on glass bottles.

You can simply adjust the maps 

when needed without the

hassle of rebuilding them for

other elements of the materials

Keep in mind the light 
direction to catch highlights 
(the yellow line)
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 Eva replies
Creating different environments 
is exciting, but to make them 
believable it’s key to study your 
references. I made this project based 

on Vivienne Gucwa’s photo Summer on Perry 
Street, NYC. It’s also an opportunity to explore 
new production workflows and to improve your 
future projects.

I used V-Ray to render the scene; working 
with the VRay2sidedmtl makes beautiful 
textures for leaves. The trees presented a 
new challenge for me and I experimented 
with many different ways to create them using 
SpeedTree – and was impressed by how easy 
it was to customise. I found I could draw and 
design the individual branches of each tree the 
way I wanted. I did a lot of research on trees 
and cannot stress how important references 
are throughout any project! Good workflows 
for importing assets are also important.

Rendering got very expensive on a 
laptop during the process of this project. I’d 

recommend for independent artists to use 
the new cloud-based rendering from Google 
Zync! It saved me huge amounts of time and 
the cost of investing in servers or a powerful 
machine. It offers great flexibility in choosing 
the power and quantity of machines you 
require for your renders. 

What is really awesome is you can send 
renders to Zync while you work on another 
project, as all the hard work is done on the 
cloud not using up your local hardware 
resources. Zync is a simple plug-in for a 
supported 3D package such as Maya and 
even Nuke. You would set up your render as 
usual – and I did a test render first on my local 
machine to check for mistakes. Once ready, 
fire up the Zync plug-in and choose your cores 
and quantity to give you a rough estimate 
cost. Then select your layers and render! Zync 
created a really user-friendly integration and 
can definitely enrich the future for rendering. 

What advice can you 
offer to help speed  
up my environment 
rendering process?  
Robin Davey , UK

MAYA | V-RAY | ZYNC  

What is really awesome is you 

can send renders to Zync while

you work on another project

TWO MODELLING AND LAYOUT 
After gathering references, I took the original photo 
concept into Maya and began blocking out my 
model for the general layout. I started with the 
buildings, sectioning each apartment and naming 
the objects. Blocking out the largest areas first is 
good for the layout. Make sure to use real world 
scale and measure things with the Distance tool. 

ONE RESEARCH AND REFERENCES 
Spend time gathering as much reference 
material as possible – you’ll thank yourself 
later. The closer to real world references the 
better! I sourced references of trees, leaves, the 
Greenwich Village area in NYC – from streets to 
building materials. I even used Google Maps for 
looking at streets and neighbourhoods. 

THREE MAKE TREES IN SPEEDTREE 
I originally used Maya’s PaintFX, but SpeedTree is 
far better, especially for designing and making your 
own trees. The advantage is being able to draw 
each branch individually, which helps with accuracy. 
You can customise the tree trunks and work with 
the dynamic of the leaves. My favourite part was 
the animation: making the leaves and trees sway. 

FOUR ADDING DETAILS AND BLOCK LIGHTS 
I started adding details to my model on the 
buildings and used Mudbox for the bumps on 
the ground. To create a closed set feeling and to 
help with blocking the lights a bit, I usually use 
simple plane polygons. Blocking out lights with 
no textures is the best way to see your light 
values and set the scene. 

STEP-BY-STEP CREATE A REALISTIC ENVIRONMENT

ARTIST Q&AARTIST Q&A
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FIVE TEXTURE MODEL 
Creating materials for look development is very 
important, so don’t be afraid to experiment. I made 
so many materials for the stone building walls and 
the ground. I used a lot of VRayMtl shaders and 
layered with the VRayBlendMtl controlled by maps 
for the blend amount. Refer back to references for 
details and look at the variation in materials. 

SEVEN CAMERA MOVEMENT AND ANIMATION 
The scene is almost complete. To make it come 
alive I add a subtle camera pan and some nCloth 
leaves controlled with nRigid, for collision on the 
ground. I actually hand-animated some individual 
extra leaves as I didn’t get the results I wanted. 
The animation complimented well with the tree 
movements from SpeedTree.

NINE SEND TO ZYNC RENDER 
Once settings are optimised, do a single frame 
render test and comp in Nuke to check for missing 
information. Then I accessed Zync plug-in within 
Maya, sending my project to the cloud-based 
render. It’s seamlessly integrated and frames are 
automatically downloaded back to your project 
folder once complete, monitoring progress online.

SIX ADDING TREES AND RELIGHTING 
I textured the trees separately and exported as 
alembic files, as they contained animation. Using 
V-Ray proxies instead of referencing files really helps 
with manageable working scenes. I imported extra 
trees to help cast realistic shadows on the ground 
and building, turning primary invisibility off. I used a 
LUT for my lighting workflow for better values. 

EIGHT SET UP RENDER ELEMENTS 
V-Ray generates render elements really well. For 
extra control, I grouped my objects into Single 
Object Properties, making sure I have a matte for 
my trees and foreground. I would also cache out 
the animation to make rendering easier and bake 
out light maps in the GI settings to save render 
time. Create your render elements as needed. 

TEN COMPOSITING AND POST-PRODUCTION 
Probably the most rewarding part of CG is 
compositing your frames together. Bringing my 
passes into Nuke, I added atmospheric effects for 
the sunlight and did some colour correction and 
grading. I added back in my LUT (Look Up Table) 
I was using in Maya for lighting in higher values. 
Happy rendering!

EXPERT TIP
Use the right version 
Use V-Ray 3.0 or later for 

importing alembic files 
directly as proxies for heavy 

data, such as trees! It’s 
lightweight and doesn’t  

create a large scene file. I 
used this for creating my 

light blockers, to cast  
realistic shadows. 

Making use of 
Google Zync helped 
speed up the render 
and make better 
use of Eva’s time
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The freelance character artist shares her incredible 
photoreal portrait sculpts packed with expression

IZABELA ZELMANSKA
ARTIST PORTFOLIO

FEATURE
Meet the artist
ARTIST PORTFOLIO
Izabela Zelmanska
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Meet Izabela Zelmanska, whose story is 
quite familiar to many artists making 
their way in the industry. She’s created 

art for as long as she can remember, starting in 
2D and moving to 3D when she began working 
in the advertising industry. But she was always 
restless, unsure she was in the right job, “I got 

bored of flying logos and reusing 
templates,” she says. “By pure luck 
I stumbled on a job offer in games 
development. It turned out to be just 

the thing for me.”
Now working at Techland in Warsaw she 

specialises in character modelling, but her 
newfound passion is for photogrammetry. 
Along with her partner, she has built a multi-
camera face scanning rig at home, in the 
middle of their living room. “We are a crazy 
couple who instead of saving up to buy own 
apartment, have spent a small fortune on 
24 digital cameras and tons of other photo 
equipment to realise our passion for 3D art.”

Face value 
It comes as no surprise that the work which 
jumps out in Izabela’s portfolio is her stunning 
portraits of people mid-expression. The ZBrush 
sculpts of screaming, shouting, pouting, 
puffed-faced people are beautifully realised. 

“Facial expressions are arguably one of the 
most difficult things to model – everyone can 
subconsciously connect with natural expression 
and react negatively when something is off, 
even if they can’t really explain what exactly 
feels wrong,” explains Izabela. 

She uses self-made face scans as a starting 
point (from her homemade rig), but uses them 
only as a base mesh before modifying them 
heavily. “It’s surprisingly difficult to find a person 
with the right face and right facial expression for 
any given project,” she says. “It pays to know 
human anatomy, facial muscles layout, and to 
study photographs on the Internet.” 

Proper research in this way allows Izabela 
to modify her base mesh in the right way; by 
putting wrinkles and skin folds in the proper 
places, she can shape facial expressions in a 
convincing way.

As for her advice to others, she says: “Don’t 
just look at real-life faces, really study them, 
analyse them, think about every skin fold, 
wrinkle, pimple and dimple you see. The more 
observant you are, the easier it gets to sculpt 
believable faces.” 

Tough challenge 
Izabela’s talent for incredible face sculpts led 
to her most challenging project: to create 
a perfectly photorealistic facial model of a 
famous music artist. The tricky part was that 
he had died many years ago so there was no 
current reference to make use of. “I had to 
base my sculpt on a rather limited amount  
of available photographs, often taken in  
tricky lighting conditions, at different ages  
and body weights.” 

To make matters worse for Izabela, creative 
photography often uses lenses with different 

focal lengths, which can alter the perception 
of facial proportions. “It was really tricky to 
extrapolate all that and get a sense of what  
he was like, precisely. I really enjoyed that 
project – I love a good challenge! To be 
honest, I get cranky if I don’t get enough of 
a challenge at work! Luckily I can challenge 
myself at home, setting out to do things I have 
not been able to do before. And I always hope 
that the best challenges are still ahead of me.”

To overcome those challenges Izabela 
reminds herself of a piece of advice given to 
her by People Can Fly’s Waylon Brinck: “He 
said, ‘always make sure your art reads well 
and flows, even when scaled down to a tiny 
thumbnail. It’s really easy to get lost in zoomed 
in detail work that actually spoils the end result 
instead of improving it.’”

FYI
Find out more about Izabela’s work at  
www.izabela-kus.blogspot.co.uk

JOB TITLE
 Character and 
creature artist

NOTABLE CREDITS
The Vanishing of 

Ethan Carter,
Dead Island: Riptide,
Assassin’s Creed IV: 
Black Flag (posters),

Silent Hill: 
Anniversary

COUNTRY 
Poland

VITAL
STATISTICS

ARTIST PROFILE
Izabela Zelmanska is a 

character artist working 
in the video game and 

film industry.
www.bit.ly/Izabela ARTIST INSIGHT

Software choices
Izabela loves ZBrush but 
photogrammetry is taking 
over her life…

I can’t imagine life without 
ZBrush. It was my first serious 
3D software and I know it 
better than I know myself – I 
can even sense when it’s in 
a bad mood and is about 
to crash! Apart from that I 
use 3ds Max, Photoshop, 
Marvelous Designer, 
and few other pieces of 
software as necessary. For 
photogrammetry, I used to do 
everything with PhotoScan 
and I thought no other 
software could even come 
close, but then I saw the 
incredible RealityCapture – 
it’s still early in development 
but can already surpass 
PhotoScan in few key areas! 
It’s crazy fast, very memory 
efficient, and well, builds 
fantastically sharp scans. 
When it matures, PhotoScan 
will really have to step up to 
keep up!

DEAD SPACE 3: LEAPER (OWN VERSION) ORC KID

Izabela spent her 
savings on a home 

photogrammetry studio 
in her living room

Facial expressions are

arguably one of the most

difficult things to model
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T he hype about Star Wars: 
The Force Awaken’s return to 
practical effects, rather than 

using CG effects, makes for buzz-
worthy news. The true story is far, far 
more nuanced.

“The fact is, this is a visual 
effects movie,” says overall 
visual effects supervisor 
Roger Guyett of Industrial 

Light & Magic. “You can’t do this 
movie without a massive visual 
effects contribution. But how you 
integrate visual effects into the movie 
and what you photograph as the 
foundation is important. J. J. 
[Abrams, director] and I had strong 
opinions about capturing as much as 
possible in camera. So, instead of a 
2,500 visual effects shot movie, we 
have a 2,000-shot visual effects 
movie. The trick is in our approach  
to that work.”

Visual effects crews on nearly 
every film will tell you they ground 
their effects in reality. So, too, 
crews on this film. The CG artists 
referenced real world locations, sets, 
and practical effects, as it would for 
any film. But they also referenced 
filmmaking techniques used for the 
first three Star Wars films. And herein 
lies the nuance.

“Our goal was to make 
everything look as if you 
could have shot it 30 years 
ago with current 

technology,” says ILM’s Jay Cooper, 
compositing supervisor. And so, a 
more fully rounded picture of the 
effects work begins to emerge.  

The filmmakers
Industrial Light & Magic’s studios in 
San Francisco, Singapore, Vancouver, 
and London created the visual 
effects for Star Wars: The Force 
Awakens, as the studio has done for 
all the previous films in the franchise. 

Many people at ILM San Francisco, 
such as digital artist Paul Huston, 
who was a model maker for the first 
three Star Wars films, had worked on 
previous films in the franchise. Paul, 
legendary VFX supervisor Dennis 
Muren, Scott Farrar and others who 
worked on previous Star Wars films, 
helped an enthusiastic crew to craft a 
modern film that paid its dues to the 
early films’ visual language.  

Indeed, many artists at ILM 
became visual effects artists because 
they saw Star Wars when they were 
kids. For them, working on The  
Force Awakens really was a dream 
come true.

Stunning CG mixes with traditional FX to create something 
new. Barbara Robertson discovers how artists at Industrial 
Light & Magic paid homage to the original Star Wars trilogy 

The making of 

THE FORCE AWAKENS

“I saw Star Wars in 
Newcastle on my seventh 
birthday,” says animation 
supervisor Paul Kavanagh. “I 

was floored by it. I couldn’t speak. My 
mother asked me if I was ok. I told her I 
wanted to learn how to make those 
spaceships fly. On this film, I felt like I 
was working on a movie from my 
childhood, coming up with cool ideas 
to put in that movie.”

Masks, puppets & digital doubles
To recapture the feeling of the original 
trilogy of Star Wars films, most of the 
characters were puppets or people 
wearing prosthetics, rather than 
the bevy of CG characters in the 
prequels. Still, visual effects artists 
played a role, carefully blending digital 
enhancements to the animatronics 
and masks to blur the line between 
practical and digital.

“Sometimes we augmented 
the [practical] characters by 
changing the mouth or 
facial performance,” says 

visual effects supervisor Pat Tubach. 
“Sometimes it was to make a line of 
dialogue look correct because of 
limitations in a mask’s performance. 
More often, it was because of scene 
changes. Hopefully everyone will be 
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THE MAN BEHIND THE MAGIC
Meet award-winning supervisor Roger Guyett 

This is Roger Guyett’s fifth film with J.J. Abrams, and along with ILM’s Pat 
Tubach, he's supervised work at ILM’s studios, the partners Hybrid, BASE, 
and Virtuous, and the 80 artists in Abrams’ Bad Robot production arm Kelvin 
Optical. Artists at ILM and its partners created 1,400 shots. Kelvin Optical 

handled approximately 800, including composites, fix-its, graphics, and some 3D. ILM 
Vancouver, London, and Singapore had teams of around 75 people each on the movie;  
ILM San Francisco had approximately 200. The award-winning supervisor received  
Oscar and BAFTA nominations for his work on both of Abrams’ Star Trek films.

WHAT IS A 
RATHTAR?

The Rathtar is one 
of the few digital 
characters in Star 
Wars: The Force 

Awakens. We quiz 
asset build supervisor 

Dave Fogler…

Is a rathtar a creature 
or a character?

It’s a featured creature. 
It has eight arms, 

suckers, a giant mouth 
and teeth.

Sounds dangerous…
It’s a terror. It’s a 

destroying machine.

Is it supposed to be 
mechanical  
or organic?

At one point, we 
built a version that 
had wrinkled skin 
and detailed veins. 

J. J.  [Abrams] said it 
was beautiful, but it 

looked like every other 
contemporary, highly 

detailed creature.

So how did you 
change it?

We backed off. During 
the build process we 

made it look like it could 
have been made with 

foam latex construction. 
Our digital creature 

needed to live in that 
world, but perform like 
a foam latex creature 
couldn’t. It had to be 

believable as a modern-
day film creature.

original films, two CG characters play 
a major role: the tiny alien pirate Maz 
Kanata, performed by Lupita Nyong, 
and the tall Supreme Leader Snoke 
of the dark side, performed by Andy 
Serkis. Motion capture for both took 
place in Serkis’s Imaginarium. 

“J. J. wanted particular 
performances out of these 
characters,” Pat Tubach says. “So, 
we went through the motion-capture 
route to get nuances that are 
impossible with animatronics.”

The decision to have the characters 
be 100 per cent digital was made  
after experimenting with animatronics, 
though. “We tried shooting motion 
capture and have that data drive a 
puppet in real-time,” Paul Kavanagh 
says. “It didn’t really work. It wasn’t 
worth it.”

Flexibility was essential, says Paul: 
“We looked at traditional animatronics 
to try to get that feel into our CG 
characters, but, Maz and Snoke  
had to show true emotion and intent. 
Lupita and Andy gave such great 
performances, we wanted to apply 
that raw data and have it come 
through the characters. We can  
really nail that with CG when we have  
great reference.” 

The London team handled the  
Maz and Snoke shots and San 
Francisco did BB-8 with help 
from Vancouver. Then Singapore, 
Vancouver and San Francisco all 
worked on the ship animation.

Falcon chase
“The main focus of the animation 
team was shot design and ship 
animation for the all-CG sequences,” 
Paul Kavanagh says. “You can’t make 
Star Wars without flying ships around,” 
Roger Guyett adds.

One of the main CG sequences 
takes place with the Millennium Falcon 
chased by TIE fighters flying above 

FEATURE
Making The Force Awakens
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unaware. In the majority of cases, we 
didn’t have to do digital doubles.”

Digital doubles stepped in when 
the action was too dangerous or 
impossible for stunt actors or puppets.

“J. J.  [Abrams] had no 
interest, and we had no 
interest, in having a digital 
Han Solo run past the 

camera,” says asset build supervisor 
Dave Fogler. “There are digital 

doubles, but they’re in cockpits of 
ships in flight and in the background. 
J. J.  filmed real actors; we only 
populated scenes with digital 
characters when we had to.”

The most famous and lovable 
character with a digital double is 
the robot BB-8. Designed by ILM art 
director Christian Alzmann after a 
drawing with two bubbles by  
Abrams, the character is both  

practical and digital. The crew hopes 
invisibly digital. 

“Someone will figure out what 
percentage of time BB-8 is digital  
and what percentage it’s a 
photographed puppet,” Dave says. 
“There’s a fair balance. The puppet is 
magnificent. We had to create a digital 
version so good you cannot tell. I 
challenge people to distinguish one 
from the other.”

With the look in place, animators 
crafted performances that extended 
the puppeteers’ acting choices 
without calling attention to the  
digital BB-8. 

CG characters
Although Abrams populated the film 
with practical animatronics and with 
actors wearing prosthetics, much 
as George Lucas had done for the 

ILM animators used 
performance capture 
data for the two all-CG 
characters: the alien pirate 
Maz Kanata, performed 
by Lupita Nyong, and 
the tall Supreme Leader 
Snoke of the dark side, 
performed by Andy Serkis. 
Paul Kavanagh, animation 
supervisor, explains.

How much did the 
animators have to rely 
on motion capture data 

for the performances?
With Snoke, we could 
apply Andy’s performance 
and just tweak the facial 
difference. We might push 
an expression harder or 
adjust the eye direction. 
However, Maz needed a 
different approach.

Why did you need a 
different approach  
for Maz?
Her facial features were too 
far from a human’s. The 

size of her eyes, nose, and 
mouth were very different, 
so when we applied data 
captured from Lupita, it 
didn’t match one-on-one. 
We could solve the head, 
jaw, and eye direction, but 
for the facial performance, 
we relied on the Medusa 
capture of Lupita on set. 

That’s the performance 
capture system 
developed by Disney 
Research in Zurich.  

How did it help?
The system provided us 
with a massive library of 
expressions and shapes 
to dial in. Using these, the 
animators could watch a 
high-resolution video image 
of Lupita’s performance  
and match-animate it 
perfectly. It was a bit of 
a cross between full-on 
motion capture and the 
approach we used to 
animate Davy Jones. It 
takes great animators. 

ANIMATING MAZ AND SNOKE
Using performance capture data for all-CG characters 

Dennis Muren would sit with me in my office each week and 

we’d look at shots… He’d ask, ‘Are you thinking this is a 

helicopter shot? Are you flying alongside trying to keep up?' 

Paul Kavanagh, animation supervisor, ILM



The spacecraft commanded by Han Solo and 
Chewbacca first appeared in the 1977 film 
Star Wars, and again in Empire, Return of 
the Jedi, and briefly in the prequel Revenge 
of the Sith. Asset build supervisor Dave 
Fogler was a practical model maker for the 
prequels, but moved into the digital world 
with Transformers. He began working on The 
Force Awakens in October, 2013.

“Even then there was a lot of discussion 
about where the Falcon would head,” he 
says. “Everyone’s early assumption was that 
we would do something different and many 
designers took a stab at it.” At various times, 
the Falcon had a black paint job, extra armour 
and bomb racks. “Over and over, someone 
would propose a change, and no one liked it. 
So,I started researching.”

Dave found miniatures used in the original 
films: the five-foot long miniature from 
Episode IV, and a three-foot miniature built to 
fly through asteroid fields in Empire. 

“I saw them both,” Dave says. “The five-
foot miniature is one of the most beautiful 
things I’ve ever seen. It’s a gorgeous bit of 
industrial design. I knew if we could make 
a digital version look that good, our Falcon 
would be fine. We all, J. J. [Abrams], the 
production designer, everyone, decided to 
base our Falcon on the miniature.”

The ILM crew started with high-detail 
scans of the miniature. Six modellers and 
texture artists then worked for over a year to 
create the digital version, notably modeller 
Jay Machado and texture artist Aaron 
Wilson, who painted the ship from one  
end to the other.

“We didn’t change the Falcon much,” 
Dave says. “It’s more detailed and at higher 
resolution so you can zoom in and look at 
mechanical stretches that are detailed and 
mechanically logical. But if you squint at it, it 
looks like the five-foot miniature. There were 
mechanical things we could have done and 
we were tempted to move things. But moving 
things felt wrong. We decided to let it feel the 
way it had felt. I love the model we built.”

BUILDING 
THE NEW 
MILLENNIUM 
FALCON
How original miniatures 
came to save the day
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FLYING JUNK
Animation teams in the 
various studios augmented 
puppets, mimicked actors and 
puppets with digital doubles, 
performed all-CG characters, 
and flew spaceships

STUDIO BREAKDOWN
“Singapore did a huge chunk 
of the work with David Dally 
supervising,” says Roger 
Guyett. “We ran Vancouver as 
an extension of San Francisco 
because they’re in the same 
time zone and the two studios 
did a substantial lump of the 
show. The work in our London 
branch started with Ben Morris 
who helped on the shoot.  
Mike Mulholland oversaw 
London’s work in post.”
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movie as we could,” he says. “But the 
Millennium Falcon moves too fast. 
I suppose we could have hired a jet 
fighter to film the desert at Falcon 
speeds. Instead, we tried slow-speed 
photography. If we needed to go 700 
miles per hour, we flew at 70 and then 
sped up the footage by a factor of 
10.  We knew it would be wrong, but 

it gave us some points of reference 
for what the imaginary thing would 
look like.”

The footage helped the animation 
team stay grounded in reality as they 
designed all-CG shots.

“We can do anything with CG,” 
Paul Kavanagh says. “Crazy camera 
moves, ships flying faster than 
physically possible, all those things 
are tempting to do in CG. But we 

wanted to move the camera only as 
fast as it can with technology today. 
And we wanted to keep the speeds 
somewhat reasonable especially in 
the Falcon chase when the ships are 
in the atmosphere over a planet.” 

Environment research
For Jakku’s surface, and that of  
other planets, the crew referenced  
a library of photographs and  
survey data. 

“We mapped how the desert in 
Abu Dhabi behaved at different 
times of day, how that affected the 
proportions of dunes, how they were 
lit, what colours they were,” Roger 
Guyett says. “So we could build our 
digital versions in a way that was 
more convincing that it would have 
been from artwork or photographs.”

On previous films, the 
environments team typically worked 
with a 3ds Max to V-Ray pipeline. 
Although the Vancouver group 
continued to do so, other teams 
moved onto ILM’s proprietary Zeno 
and Clarisse pipeline.

“The big hangar in the Star 
Destroyer is a massive environment,” 

the desert planet of Jakku. Jakku is a 
graveyard of rebel ships from battles 
many years ago. Although ultimately 
many of the shots would be digital,  
the work started with real footage  
shot by Roger. 

“For Episodes IV, V, and VI, George 
[Lucas] went to the locations, which 
set up the idea that we’re in a real 

place even if they only used the 
backdrop and the light,” Roger says. 
“He moved away from that idea for 
the prequels. But, we felt strongly 
about filming the locations.”

With that in mind, Roger tried 
to photograph a version of all the 
sequences, even if they would end 
up as digital shots.

“We tried to shoot as many plates 
for shots we thought would be in the 

It [the X-Wing] glides through a trench… With the

environment in Clarisse, effects could work with our

scene, which made it so much easier to push the look

Susumu Yukuhiro, environments supervisor

THE TOOLS
ILM's toolset for creating the effects   
Like all studios, ILM uses a set of proprietary tools and 
off-the-shelf software. The main proprietary tool is the 
studio’s Zeno pipeline. For effects on this film, the toolset 
included Houdini, Zeno’s particle system, ILM’s Plume for 
fluid effects, the new position-based dynamics engine, Cell, 
a GPU-based renderer that runs with Plume, and to render 
most of the effects, Clarisse. The proprietary simulation 

software is based on the FLIP grid-based solver. Modellers 
built the ships and characters in Maya.  Artists in San 
Francisco, Singapore and London created environments 
using Clarisse; those in Vancouver used 3ds Max and 
V-Ray. Ships were rendered via a Katana and Renderman 
pipeline. The London studio also used Arnold. Compositing 
happened through Nuke. Deep compositing.

FEATURE
Making The Force Awakens
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ON SET EFFECTS
Care was taken to film 
as much in camera as 
possible, but there's still 
2,000 effects shots in 
The Force Awakens

MIXING OLD AND NEW VISUAL EFFECTS TECHNIQUES
“We went back to the methods from the original films and studied the work. They used techniques that we,  
as contemporary filmmakers, are familiar with. But it would have been mad to ignore all the tools available  
to us today. They’re part of the modern filmmaking arsenal,” says Roger Guyett, visual effects supervisor



“When they were building the practical 
model, I took the CAD data and created 
a simple rig for a digital model,” says 
animation supervisor Paul Kavanagh. “I only 
had a day, but I did some quick animation 
tests and sent them to J. J. It was the first 
time anyone had seen him move. A few good 
things and bad things came out of it: J. J. 
knew what he liked and didn’t like.”

Abrams liked the way Paul had BB-8’s 
head lead the action. Paul had the robot’s 
head tilt down, it would move, and then the 
adorable character would rock back to stop 
himself. Abrams also liked the performance.
“I thought it would be fun to have BB-8 

loose and wiggling, with a little aerial bop,” 
Paul says. “He never stayed still. He was 
always rocking on the ball.”

Abrams didn’t like that Paul had put BB-8 
on a straight path, though. “He thought 
that looked dull,” Paul says. “So he had the 
puppeteers wiggle him as he goes away. 
He’s always weaving back and forth.”

J.J. Abrams stopped Paul from doing more 
testing after that; he wanted the puppeteers 
to develop the character, to bring out BB-8’s 
performance on set. “A lot of the movie 
is the real puppet in several variations” 
Paul says. “He was remote controlled or 
puppeteered through controllers. As soon 

as he was on screen in Abu Dhabi, we fell in 
love with him straight away. The puppeteers 
brought so much character to BB-8 through 
that shoot. We matched their performance 
and we did shots the puppet couldn’t do.”

It’s the CG BB-8 that spins inside the 
Millennium Falcon during the Falcon chase 
sequence. Digital BB-8 is in the back of ships. 
and in other scenes, too – but you won’t be 
able to tell.

“Our CG model looked so good you can’t 
tell which is the puppet and which is CG,” 
Paul says. “All we had to do is breathe life 
into him. We can’t even tell. ‘Did we do 
that?’ we ask each other.”

ANIMATING BB-8
Animation supervisor Paul Kavanagh discusses the droid's development 
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SPOT THE DIFFERENCE
The CG model created of 
BB-8 was so impressive 
it was impossible to tell 
which was the puppet 
and which was CG 
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says Dave Fogler. “The new 
environment construction toolkit 
allowed modellers from our digital 
model shop to contribute to the  
set. And it is modular; it didn’t 
exclude Max artists, they could 
create a subset that we folded into 
the parent, but it opened the door  
to collaboration.”

With the new toolset, the artists 
created environments for shots on 
the desert planet of Jakku, which 

referenced footage from Abu  
Dhabi; for the Star Killer Base,  
which referenced footage  
from Iceland; the Castle battle  
sequence, which takes place  
in a picturesque English  
countryside environment; and  
for smaller sequences such as  
the Mesa Village.

The challenge for Jakku was 
populating the sand dunes  
with damaged ships. 

“The Falcon travels really 
fast and yet we have to 
recognise these ships,” says 
ILM’s Susumu Yukuhiro, 

environments supervisor. 
“Surprisingly, the original films didn’t 
have many iconic big ships we could 
use to fill the space. The Star 
Destroyer is big. Everything else is 
small. The X-Wing is so tiny we 
couldn’t see it. So, we cheated. We 
put multiple Star Destroyers in 

SETTING THE SCENE
One of the challenges 
was populating the  
sand dunes with 
damaged ships 

FINDING THE BALANCE
“Sometimes what’s 
physically accurate 
and correct is not 
emotionally accurate,” 
explains compositing 
supervisor, Jay Cooper



How did the review go?
He had comments on half a dozen shots. 
Some of our final shots have some of our 
biggest simulations ever. We had pre-
comps and pre-comps for our pre-comps. 
Hundreds of layers. 

What were the biggest shots or 
challenges you worked on?
The ones where we’re bridging some 
portion of something on set and have 
transitions to CG. When we have huge 
amounts of simulations, explosions,  
and environment work, things get large 
and complicated.

Were they the hardest shots? 
The hardest shots are the ones that are 
completely synthetic. We don’t have 
anything to hang onto. When we’re 
working with something real, it informs the 
entire palette, and tells us which things are 
important. When you can do everything, 
every door is open. 

Were there many greenscreen shots?
Surprisingly more than you would think. 
As much as we had real locations and sets 
and practical puppets, the Millennium 

Falcon is CG. Any ship moving is CG.  
Any time we’re in space it’s CG,  
obviously. And environments were 
embellished and enhanced. We start with 
as much in camera as we can get, but  
it’s a collaboration.

How much did you reference the 
original Star Wars films?
There was a concerted effort to bridge the 
past and make this film feel a little like that 
but not antiquated or anachronistic. The 
last three films had a clean digital look. 
Our goal was to make this film look more 
organic – make things less perfect.  I think 
the look of this film is more tactile and real 
than the last three films. 

Did you do anything new for this film 
that proved a challenge?
We did a lot of asset-specific setups: a 
new lightspeed look for Han Solo, new 
engine setups for the Falcon and X-wings, 
and setups for digital characters. We had 
a huge comp setup for Maz to tweak 
everything from her glasses, to the 
refraction in her eyeballs, to the look of her 
hair and jewellery. And, we did laser blasts 
in Nuke, in 2.5D. That was a first.

FEATURE
Making The Force Awakens

different positions broken up in 
interesting and different ways on a 
shot-by-shot basis. We tried to keep 
them as genuine as possible.”

A sequence inside the Star Destroyer 
with the Falcon and TIE fighters helped 
convince the environments group to 
move to Clarisse. “There is a lot of 
complex geometry in that sequence –  
lots of instancing. Clarisse was helpful 
getting those scenes when we’re flying 
through expanses, such as the Star 
Destroyer, up and running quickly,”  
says Pat Tubach. 

During the battles, to manage 
destruction resulting from explosions 
in the air as well as crashes on the 
ground, the effects team used a new 
position-based dynamics system 
written by effects TD and R&D 
engineer Rick Hankins.  

“For destruction, you want 
varying levels of detail 
interacting,” says Daniel 
Pearson, effects TD 

supervisor. “Some techniques are 
better than others for simulating rock 
through dirt to dust. You can either 
use multiple solvers one after the 
other, or a position-based set to have 
varying levels of detail within the 
solver. It doesn’t handle everything, 
but it handles a lot.”

The effects team also used Clarisse 
to render the majority of effects, due 
to its ability to handle massive amounts 
of geometry. Also, it made it easier to 
integrate the effects into environments. 

PUTTING IT ALL TOGETHER
Compositing supervisor Jay Cooper talks about 
reviewing the last 10 shots with J. J. Abrams
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“Effects and environments shared 
scenes,” Susumu Yukuhiro says. “We 
could take their explosions and smoke, 
and they would cast shadows on our 
environments. We’d get interactive 
light. And they could take our scene to 
create their effects.”

At ILM Vancouver, the team used 
the 3ds Max and V-Ray pipeline 
to create a castle used in a battle 
sequence, with SpeedTree helping the 
team add dynamic trees and grass. 
The main location for this sequence 

was the backlot at Pinewood. There 
was no castle; only destruction. 
The ILM artists reverse engineered 
the former castle’s orientation, and 
using plates from the Lake District in 
England, created an ancient castle in a 
charming countryside location.

Environment artists also extended 
the icy Starkiller Base location filmed 
in Iceland. “We augmented the 
landscape quite heavily in unique 
ways,” Pat Tubach says. “People will 
find it reminiscent of previous Empire 
bases, but this location takes it to a new 
level. The base is a hacked planet.  

J. J.’s idea was to have a natural setting 
mixed with technology. It becomes 
revealed as the movie progresses.”

For Pat, the biggest challenge 
in creating the VFX for this film was 
maintaining the legacy. “That sounds 
like a high concept thing, but it means 
paying attention to work done before 
and trying not to do anything out of 
character. If we came out with a movie 
that had the feeling of a modern CG  
film and not in the same vein of the  
original trilogy, it would have 

disappointed the fans and it is not what 
J. J. [Abrams] wanted. We took ideas 
from those films and pulled them into 
this film in an interesting way to make it 
feel like anything new was only 30 years 
newer than what we’d seen before.”

Today’s blockbusters often use 
visual effects to create the impossible. 
For Star Wars: The Force Awakens, 
the artists concentrated on aesthetic 
choices rather than technical fireworks 
– on creating the possible. Possible, 
that is, in a galaxy far, far, away.

FYI
Find out about the game at  
www.bit.ly/3dw-ilm-history

There’s a charm to optical effects, but when we look

back, they’re not at the level we expect… They are  

historically interesting but we're in no rush to go back 
Jay Cooper, compositing supervisor, ILM

This was the first film where the ILM visual 
effects crew created lightsabers using 
particle effects rather than roto shapes and 
2D composites. Effects TD supervisor Daniel 
Pearson explains how his crew created the 
effects: “We referenced Luke’s lightsaber 
from 1999, and had lots of look development 
and concept art from the client for the red 
lightsaber. One of the side effects of hand roto, 
which we used in 1999, is a lovely dynamic 
edge. So we developed a procedural way to 
mimic that look. We cached off sequences of 
VDB grids to represent different aspects of the 
blade and used them over and over again. The 
mandate for Kylo Ren’s red lightsaber was for 
it to look like he built it in his garage. It was 
dangerous, violent, barely contained – scarier 
than the refined lightsabers the Jedis built. The 
edges are more erratic and it has these almost 
electrical lightning strings that pop out of the 
surface through the battles, and a dangerous 
flicker. It even sheds sparks spontaneously as 
though it’s barely holding itself together – we 
used particles for these. We didn’t want to 
overplay. We handed off the technique to 
other facilities; BASE created a few.”

LIGHTSABER 
CG EFFECTS
Using particle effects to  
create the iconic weapon

WEAPON DEVELOPMENT
Kylo Ren’s red lightsaber 
was intended to look 
more dangerous than the 
refined lightsabers made 
by the Jedis 

CHALLENGING WORK
The team found the 
hardest shots to be 
those that were totally 
synthetic. Any ships 
moving are CG 
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ICONIC DESIGN 
For Josh, the chaotic 
nature of IG-88 with 

his cylinders and tubes 
really works 

TOPICS COVERED
 Concept design
Reference
Modelling
Rendering
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REDESIGN AN ICONIC 
ROBOTIC CHARACTER
Josh Herman reveals his tips for creating an 
original character for film production

I always have new ideas 
popping into my head, as well 
as hundreds of projects that 

I want to do – and would – if I 
had the time. But some of my 
favourite projects are designing 
new versions of characters that I 
love. However, here’s the thing: 
I don’t like the typical characters 
that everyone else does. I like 
the weird ones, the oddballs, the 
outsiders, the B team or even the 
C team. It’s just who I’ve always 
liked. I’ve never wanted to redo 
the heroes from a new franchise, 
I want to remake knights that are 
eight pixels tall from a coin-op 
arcade game and turn them into 
fully fledged characters with 
backstories. I want to reimagine 
characters that are fun, quirky, 
unique and iconic.

With this, they become 
incredible design challenges. 

Keeping the spirit true to a 
character that has such little 
backstory can be surprisingly 
difficult. They aren’t as well known 
as other characters, so you need 
to retain more of what people 
remember about them, while 
trying to add your own flavour. 
But the opposite side of that 
coin is that most viewers won’t 
remember much, so if you can 
keep that one aspect then you 
can go crazy with the rest of it.

With the onset of the new 
Star Wars movies, I thought I 
would do one of my favourite 
characters from the films. If you 
hadn’t guessed it he gets about 
10 seconds of screen time and 
says no lines, but yet most fans still 
remember him – even if they don’t 
know his name.

IG-88 is a character that people 
remember, mostly because he 

ZBRUSH | KEYSHOT 6 | MAYA 2016 | PHOTOSHOP

was a goofy looking droid in the 
background when we’re introduced 
to Boba Fett. But in being goofy 
looking, people miss that he’s 
incredibly iconic. Iconic design 
doesn’t mean it needs to be really 
cool looking. There is something 
to the chaotic nature of this robot 
made of cylinders and tubes that 
really works. 

In the tutorial I will go through 
how I remade the most dangerous 
droids in the galaxy. I will show 
you my sculpting process, 
retopologising techniques, and 
rendering pipeline to come away 
with the 2D/3D design.

I had so much fun creating this 
guy that I might just redo all five 
of the remaining scum when I 
have time – and I hope you enjoy 
seeing my process.

For all the assets you need go to 
creativebloq.com/vault/3dw204
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ARTIST PROFILE
Josh Herman
Josh is a lead 
character artist at 
Marvel Studios and 
a teacher for www.
conceptartworkshop.
com. He can be found 
at www.littlebluebot.
com and will be 
launching www.
ecretLabs.xyz with co 
owners Charlie Wen, 
Travis Bourbeau and 
David Finch in 2016. 
www.droidsforsale.com

CHOOSING A 
CHARACTER

Once I decided on Star Wars, 
IG-88 was pretty high on the 
list of characters I wanted to 
do. I love all the bounty 
hunters equally, but this droid 
has always intrigued me and  
I really wanted to get deep 
into the design of him and 
figure out why it worked. He 
has an odd charm because of 
his contrast of simple shapes 
and odd shaped head, 
combined with his story of 
being the most dangerous 
droid in the galaxy. Oh, and 
that head can look 360 
degrees at once… creepy.

EXPERT TIP
Use existing references
Always look for as much reference 
material as possible. The great thing 
about IG-88 is that he has appeared 
in a lot more than just the movies. 
The TV shows, comics and books 
have tons of info on him. So here 
I reread the Tales of the Bounty 
Hunters, which has a short story 
devoted to him and explains a lot 
about how he thinks and what  
he’s capable of. It was an  
invaluable resource.

DESIGN CHALLENGES
If you want to redesign something that is kind of odd or silly looking, 
the last thing you want to is take that part of the design away. Yes, you 
can change it to make it look cool, but then is it still that character? 
Will it even be recognisable? I know that I could make a much cooler 
head for IG-88 with lots of eyes, but would you change the calling 
card of the design? In the end I kept that shape and tried to use as 
many cylinders as possible to reference the original.



BASE MESH BLOCK OUT
When developing in 3D, spend 
some time in ZBrush or Maya 
playing with shapes to start to 
get a feel for your character. 
For IG-88 I brought in simple 
primitives to put all the pieces 
together. I’d advise to start with 
the head, then move to the 
torso, hips, and end with the 
limbs. I find that starting central 
and adjusting as I go helps  
me get to an end product  
that fits together better.
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THREE DETAIL IN ZBRUSH
Make sure you’re using both 
2D and 3D to their strengths. 
Sculpting fine details in 
ZBrush is a lot easier than 
modelling them in Maya. But 
painting can be even easier. 
Use whatever solution works 
best for your end goal.

TWO ADAPT YOUR WORKFLOW
Once you hit a roadblock in 
2D, jump over to 3D to solve 
the problem. It works the other 
way as well. When you struggle 
to find a solution in 3D, take 
a screenshot and sketch on 
in Photoshop. Don’t lose your 
momentum in the creative process.

ONE FIND THE SHAPES
Use whatever medium you 
are most comfortable with 
to find your initial shapes. 
Some people prefer to use 2D 
sketches or silhouettes. I like 
to use 3D because I can view 
it from all angles. Don’t limit 
yourself at the beginning.

WORKING TO THE DESIGN 

HUMAN SCALE REFERENCE
When working on a new character, put a human 
scale model in the scene to use as a reference. 
It works almost like a ‘control’ character from 
a scientific perspective. This is especially good 
to do when creating mechanical characters. It 
keeps you on point for the size of details like 
bolts, screws and cut lines.

FIND THE CHARACTER
Once you have a block in 
complete, spend some time 
exploring the reference and 
sculpt to find the existing 
shapes of the character.  
This helps understand what 
it was about the original 
design that worked and 
what can be changed. For 
IG-88, I saw most of his 
design lines were vertical, 
with some horizontal. But 
very few were diagonal.
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MAKE SURE IT’S WORKING
Once you feel like you’re at a good place with 
how the detail is coming along, jump into 
KeyShot and get some quick renders out and 
then spend some time painting on them in 
Photoshop. I find this lets me know if I’m still 
heading in the right direction and also informs 
me if I have too little or too much detail.

MATCHING  
THE DETAIL
When you have a good 
template from the focal 
point, you can use it as 
a visual guideline to 
inform the rest of your 
character design 
choices. However, even 
at this point you might 
need to adjust the  
areas you’ve been using 
as a template. I’m 
always adjusting and 
tweaking the model 
until I’m happy with it.

WE CAN  
REBUILD HIM
When retopologising  
I recommend 
decimating and 
exporting your model 
from ZBrush and into 
Maya. With the sculpt 
geometry complete, you 
can then begin the long 
process of rebuilding the 
model. I like to get 
nearly every surface 
covered before I move 
onto any details.

EXPERT TIP
Which brushes? 

I like to use the Dam_ 
Standard brush to sketch 
in details for panel lines 
and other details inside 

the body. To explore 
larger shapes I use the 

Clay or Clay Buildup 
brushes.

FOCUSING ON THE FOCAL POINT
Once you have a good start on your 
character, it’s a good idea to hide the 
areas that won’t be in the focal point of 
your 2D final illustration and start 
exploring the core details and secondary 
shapes of the character. For IG-88, this 
gives me a good template for the rest of 
the character and also enables me to 
save time by only detailing a small, 
relevant section of the character.

EXPERT TIP
Move between apps  

Using the ZBrush to 
KeyShot Bridge you 

can take out hours of 
decimating, exporting 

and importing. It’s super 
fast and easy. It’s well 
worth the investment 

and will save you  
lots of time.

DON’T TRACE
When retoping precise, mechanically-built characters, tracing the 
lumpy sculpt geometry can leave a lumpy model. Use the sculpt as a 
guideline for general size and shape for the new model. The design 
process doesn’t end with the sculpt. There are still lots of choices to 
make while rebuilding all the pieces. Detailing a sculpt usually means 
pores; detailing a mech means edge loops and refining surfaces.



MAKING IG-88’S GUN

THREE MAKE THE BARRELL
To make the barrel I boolean out 
several cylinders from a larger 
cylinder used for the barrel. I extrude 
it inwards to create the thickness. 
The geometry is messy, but I make 
sure not to Sub-D for the final render. 

TWO CHECK PROPORTIONS
Instead of modelling it from image 
planes, I just used the existing 
gun as a reference and add 
what is needed to make it fit his 
proportions, adding some of my 
own details as I saw fit.

ONE USE REFERENCE
For IG-88’s gun I chose something 
that was already existing in the 
Star Wars universe and was iconic 
to the character. I choose the DLT-
20A blaster rifle because most of 
his action figures came with it.

LIGHT & MATERIAL PREP
Once the model’s finished I go 
into KeyShot and set up some 
basic lighting and materials for 
the final image. They don’t 
have to be perfect as you can 
perfect them once the pose is 
done, but this gives you one 
last chance to see if there is 
anything missing before you 
start your pose. For example, 
here I decided to add some 
detail inside some of the eyes.
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RENDER CHECK
My IG-88 model is getting 
really close to final, so I jump 
back into KeyShot to get 
some more renders done. Just 
like before, this is to check 
that the surfaces and details 
work well together. I 
recommend doing these as 
you get closer to the end 
because you can start getting 
a feel for what you want to do 
in the final image and pose.

PUSHING FORWARD
Modelling and adding details 
can feel like a long slog, so I 
recommend starting at a focal 
point and spreading outwards 
until everything is covered. It 
helps to move one piece at a 
time so you can see the 
progress. Breaking the job into 
small chunks like this helps make 
a big job feel less overpowering.

DON’T BE AFRAID TO  
MAKE CHANGES
The design process doesn’t 
end until you’re done with 
the project. Here you can 
see that I was unhappy with 
the proportions of the head 
so I shifted all the pieces 
around until I got something 
I liked more. Send work in 
progress images to friends 
to get outside opinions – it 
helps! Strive to make 
changes that are better,  
not different.



FINAL PAINT PASS
When bringing everything together with a final layer of digital paint, 
it’s best to merge all your layers together to keep the file size down 
before you begin to paint. For IG-88 I add some details, photo 
textures and Curves layers, as well as some overall noise to bring the 
image together. At the end I merge it all one last time and create  
a blur to regain the focal point.

PHOTOSHOP COMPOSITE
Compiling all the renders together is my favourite part. 
Sometimes an extra pass put on an odd blending mode can turn 
into something awesome that you didn’t expect. Start with your 
base render and cycle through each new layer and all the 
blending modes. Here, I also create masks on the metals to see 
what different types of metal look like.

FINAL PASSES
I use KeyShot to render passes. Passes are where 
you render images you plan to composite later. It’s 
good to have one base image with the breakout of 
materials you want, but also render out other styles 
in case something works. I rendered several metal, 
cloth, and types of shading to help in Photoshop. 
More passes give more options when compositing.
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POSING FOR THE SHOT
Posing can be really fun and easy, or it can be 
a total nightmare. With this hero shot I want to 
portray him in a simple and classic composition – 
much like the first time we see him alongside all 
the other bounty hunters in Empire Strikes Back. 
I suggest using ZBrush to pose your characters, 
using the Transpose Master plug-in, as I did here.



CREATE A CLASSIC STAR 
WARS ILLUSTRATION
Pascal Blanché reveals how to harness essential 3ds Max 
and ZBrush techniques to create a stylised illustration

3DS MAX | ZBRUSH | KEYSHOT
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ARTIST PROFILE
Pascal Blanché
Pascal has worked 
in the video games 
industry for over 20 
years and is a senior 
art director at Ubisoft 
Montreal. He has 
worked on Myst IV: 
Revelation, Naruto: 
Rise of a Ninja, James 
Cameron’s Avatar, and 
many more.
www.3dluvr.com/
pascalb



INSPIRING DESIGN
Pascal’s illustration 
was influenced by 
the artistic legacy 
of Star Wars 

When 3D World asked 
me to make a Star 
Wars homage, I didn’t 

hesitate for one second! You 
see, I am one of those guys 
old enough to have seen the 
original trilogy on the big 
screen. Okay… starting with The 
Empire Strikes back, as I was 
too young for A New Hope. You 
have to understand how big of 
an impact that movie had on my 
childhood back then, and with 
Star Wars: The Force Awakens in 
cinemas, it really feels good to 
get that feeling again – but this 
time with my kids!

I am a big fan of classic sci-fi, 
and to me, Star Wars goes along 
with the names of great artists 
like Ralph McQuarrie and Joe 
Johnston, who are truly the two 
visionaries behind the Star Wars 
magic. Though he’s no longer 
with us, Ralph’s concept art for 
A New Hope still permeates 
through the Star Wars franchise, 
from TV’s Rebels to the latest 
movie. So in keeping with the 
artistic legacy of Star Wars, my 
illustration has to reflect that 
particular aspect.

This tutorial will explain my 
process for creating stylised 

illustrations. We’ll be using some 
core techniques in ZBrush and 
3ds Max, as well as looking at 
how to render and tweak the 
illustration in KeyShot. 

We’re looking at purely still 
illustration here, so we’ll be 
touching on some key aspects 
of classic, traditional artwork 
creation, such as composition and 
colour balance. I hope you find 
some of the techniques useful 
for developing your own art, 
style and even refreshing your 
portfolio. Now, let’s get started…

For all the assets you need go to  
creativebloq.com/vault/3dw204
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Colour balance 
Rendering
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ONE MODIFIER MENU
In the Greeble 3ds Max Modifier 
menu, select Greeble. This will 
instantly create subdivision 
panels for you. Turn off the 
Widget panel for now and nudge 
the main panel presets a little, 
up to a result you like. You can 
use the Random Seed tab to 
experiment with different tests.

TWO GREEBLE MODIFIER
Pick up and place a new Greeble 
modifier on top of your cubes, 
but this time generate the Widget 
panels only. Make sure you have 
the panels turned off and keep the 
original geometry turned on, or 
some of the faces will disappear.

THREE NOW EXPERIMENT 
You can then continue building 
up the blocks by adding a 
new Greeble and playing with 
widgets and panels. With a bit of 
experimentation you can create 
star bases, spaceships and lots 
of sci-fi structures in no time. 
Be careful with that stacking 
technique though as your 
polygon numbers will go off the 
charts in no time.

4 CHARACTER RESEARCH
Once again I want to create something that was an 
inspiration from the Star Wars universe, not specifically 
something ‘canon’. I always liked the smuggler/rogue 
warrior type of character in the old trilogy so I aim for 
a lead female warrior; strong with the force but she still 
leaves her options open (a crude blaster). My research 
includes studying Ralph McQuarrie’s original designs. I 
love the simplicity of the clothes and lines from the 70s 
artwork and aim to bring it back into my final design.

3 CREATING DETAILS
On the side of the larger ship I start to add tiny little 
objects to break up the shape and add visual contrast 
to the surface. Eventually I also grab shapes from 
other, older models (like they did back on the first 
movies). For example, I pick model tank elements 
to create the complex technological details. In 3ds 
Max I use a great plug-in called Greeble (www.max.
klanky.com) that adds basic square shapes on top of a 
geometry, which speeds up the process.

5 THINK ABOUT THE POSE
The pose is always the starting point when I create 
an illustration. Here I look at old Star Wars posters 
to find some inspiration, and draft a heroic pose 
that can work with the character I have in mind. 
To do so, in 3ds Max, I use my female model that 
is already rigged and skinned. I then mix in some 
influences from Han Solo and Luke Skywalker’s 
‘ready for action’ poses, while making sure the 
whole silhouette is readable.

1 CONSIDER THE CONCEPT
What I want to create is an illustration that sums up – 
in one image – the different aspects of the Star Wars 
franchise: space fights and lightsabers. But also, I 
don’t want to replicate what has already been seen 
before; I aim to rework those key elements to create 
my own version of Star Wars, while staying true to 
the original universe. So I end up with the idea of 
a Jedi/smuggler character with classic TIE Fighter 
versus Millennium style of ships.

2 START WITH BASIC SHAPES
I start with some simple shapes to get the classic 
Millennium Falcon and TIE Fighter silhouettes. I then 
begin to refine key elements while playing with new 
variations on the classic designs. Always try new things 
and develop old ideas, rather than just reproduce 
someone else’s originals. This is good technique, to 
learn how to create new designs for concept art; it 
makes you think about what particular shapes define 
those ships and what makes them so special.
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STACKED OBJECTS
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10 APPLY SHADERS IN KEYSHOT
When all the textures and models are done I export the 
whole set into KeyShot. KeyShot has very convincing 
lighting, good shaders and amazingly fast rendering 
speed – even with high resolution. Most of the time I 
use the Plastic or Metal Paint shaders as a base for my 
elements. I isolate the different body parts so I can 
add different types of shaders to each element. For 
example, the sky is glossy, fabric plain, and the boots 
have a small specular that reflects light like leather.

9 BEGIN TO TEXTURE
To help the readability of the model in the rendered 
shot, I create a main colour pass (blue for the skin, 
light beige for the clothes) and then a gradient from 
top to bottom (legs and feet get darker). I like to 
highlight reliefs in my texture work using different 
masking tools, so I can isolate areas I want to darken. 
ZBrush is quite amazing for these little features. For 
example, you can create very precise texture work 
where a few years ago it would have taken ages.

6 GET YOUR SHAPES RIGHT
Now I create a mesh from the pose (using Snapshot) 
and export it into ZBrush. I block out the general 
shapes of the trousers, using the Clay, Standard, 
Inflate and Dam_Standard brushes. Next I 
extrapolate shapes from the body to create the top. 
During this stage I refine the proportions: I scale 
up the head and elongate the legs. Using a rigged 
character can feel limited when creating dynamic 
poses, so you need to push it as far as you can.

8 PREPARE YOUR OBJECTS
The details are done so I merge all the elements 
together – but do so in stages. For example, I merge 
the tentacles, vest and main body together. I make a 
copy of the mesh to keep a detailed version and do 
a ZRemesh pass on the original to create a UV pass, 
then subdivide it again and remap details back from 
the copy. Knowing that details won’t show up that 
much on smaller elements, I only concentrate on the 
main body for my textures.

7 ADDING THE DETAILS
Even though I want a simple look there are a lot 
of elements that need to be added to create a 
believable hero, such as belts, pouches, buckles, 
and of course, the blaster and lightsaber! I have a 
lot of fun creating these weapons, but also make the 
process as easy as possible by using Greeble in 3ds 
Max to create objects for the blaster. I then export 
them to ZBrush to refine. Other elements were made 
in ZBrush then added on top of my model.
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CONTROLLING DETAILS
Don’t go overboard on 
details, as smaller details  
won’t show up – the ones 
in the mesh will be plenty

BEST PRACTICE 
Strike the pose
Think pose and composition first. 
It might be a very obvious tip, but 
so many times I’ve seen artists 
creating their characters without 
really thinking of what to do with 
them after they are done. If you 
want to have a good portfolio then 
give life to your characters! A good 
pose and good composition sells 
your work better that a TPose!



GREAT COMPOSITION
The trail from the larger ship 

and the laser shots, as well 
as the planet shapes in the 

background, help it to frame 
and guide the viewer

14 FINAL ADJUSTMENTS
With the illustration complete it’s time to look at it 
with fresh eyes, find the problem areas, and add all 
the last little details to polish the illustration. I decide 
the eyes need a little more life and a quick pass 
using photo references means I can add an extra 
Death Star base into the background, which helps 
to balance the composition and highlight the TIE 
Fighters. Remember, always take time to evaluate 
and develop your final illustration! 

13 COLOUR CORRECTION
Now that I’m happy with the general look, it’s time for 
some colour correction and refinement. A technique 
I like to use is to isolate the shadows and the 
highlights, and to colour them separately. I usually go 
for cold colours in the shadows and warmer colours 
in the highlighted areas, as this helps to harmonise 
the tone of the illustration and give it its particular, 
cohesive feel. Don’t underestimate the importance 
of this stage, it can make or break your art.

12 REFINE THE COMPOSITION
Now in Photoshop, using the alphas I created 
to isolate the different elements, I work out 
a composition that blends the ships and the 
character into one scene, and use Star Wars’ poster 
artist Drew Struzan as a reference. The trick here is 
to get one or two lines of direction to help lead the 
eye around the image and land on the areas you 
want the viewer to focus on. As well as ultimately 
creating a readable image.

11 CREATE THE RENDER
I decide to render the ships and the character 
separately in order to avoid the different elements 
fighting too much for what will work best in my 
camera view. Doing two separate renders in this 
way allows me to concentrate on one subject 
only, and get it right without overcomplicating 
the process. Using some of the KeyShot Dome 
lighting presets I create some tests to try out 
different styles and moods, but most of the time 

a simple top/bottom approach is always the best. 
KeyShot comes up with emissive shaders as well, 
which enables me to create a nice green bounce 
light for the lightsaber that helps to sell the idea 
of a hot light source. Next I set up the render to 
create a high resolution version. And remember, 
never forget to export in a Mformat that supports 
alphas – you always need your alphas for 
adjustments later on!

62 3D WORLD  February 2016 www.youtube.com/3dworld

TUTORIALS
Create a stylised illustration

BEST PRACTICE 
Colourimetry
Try not to go further than three 
main colours on your character. 
Too much colour makes it hard 
to read and the eye of the viewer 
goes all over the place. Keep it 
simple and try to be bold too. A 
character with a big stroke of red 
or blue, in this case, attracts the 
eye. Try to guide the eye where 
you want it to focus on; keep 
more mute colours for things that 
are secondary.
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SIMULATE A LIFE-LIKE 
SUMO WRESTLER
Ehsan Kiani shares his process for creating a 
realistic character fat simulation using nCloth

In this tutorial I’m going to show 
you how to set up a solid fat 
simulation for your character or 

creature in Maya, using nCloth.  
nCloth is a very powerful 
simulation toolset inside Maya 
which has been underused in 
studios when creating muscle and 
fat simulations. A lot of studios 
end up writing their own toolset 
for muscle and fat simulations 
which can end up being more 
expensive, and not to mention 
time consuming. 

I use nCloth for a variety of 
solutions, such as muscle, fat 
and crash simulations as it is 
a simulation toolset designed 

for multi purposes. In addition, 
it’s very flexible, which means 
with a little imagination you can 
find solutions for your needs 
that essentially nCloth was not 
designed to do in the first place. 

Once in a while we face 
characters or creatures that have 
a lot fat on their body, and the 
technical directors usually tackle 
this problem with custom plug-ins 
or built-in deformers. However, 
what if you don’t know how to 
implement a jiggle deformer 
plug-in? It would be a long way 
to develop such a plug-in that 
can interact in Maya and is solid 
enough to not break or work 

properly. But with nCloth your  
life will get much easier and it  
will be fun to do these types  
of simulations. 

The character I have created 
here to show you the process 
of fat simulation, was modelled 
by Ghasem Mullahassani. We 
recently worked together on a 
personal project and I chose this 
model as it had a massive amount 
of fatty tissues, so I could go 
extreme on the fat simulation. 
Follow the steps below to simulate 
the jigging fatty parts of your 
character or creature as you wish.

For all the assets you need go to  
creativebloq.com/vault/3dw204

MAYA

1 DO YOUR RESEARCH
Whenever I want to simulate something based on 
reality, I always check out the real world first. In this 
case, we need to see fat and skin layers in the human 
body and understand how they work. I’d recommend 
a search online, but you should really look to pick up 
artists’ anatomy books and medical books so you 
have a reference to hand when a project like this 
surfaces. The layer we’re most interested in for the 
simulation is the ‘superficial’ or epidermis layer.

2 GET YOUR MESH RIGHT
Mesh topology is one of the most important basics 
to get right when working with character rigging 
and deformation. After you model your character, 
you need to retopologise the mesh with clean 
quad polygons. We’ll use this new mesh as our 
deformation mesh. In my experience, working with 
meshes with no muscle definition in their modelling 
topology can offer much better results when it 
comes to sliding muscles beneath the skin.

FOLLOW
THE VIDEO

If you see the Play icon,
use the link!

TOPICS COVERED
Model preparation
nCloth mesh
Dynamics
Jiggle mesh
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SUBCUTANEOUS FAT
Below the skin

VISCERAL FAT
Surrounds organs

ABDOMINAL 
MUSCLES



ADDING THE POUNDS
nCloth is a great tool 

for muscle and fat 
simulation, making it 
perfect for creating a 

sumo wrestler

CLICK TO PLAY VIDEO
www.bit.ly/204-muscle-1

CLICK TO PLAY VIDEO
www.bit.ly/204-muscle-2
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TWO CHEST FAT
Again, I duplicate the main 
body and rename it ‘chest effect 
target’. Then, as before, skin 
wrap it to the chest fat objects 
and it should be added to the 
blend mesh as well.

THREE BLEND MESH
Now open up the Paint Editor 
and paint the effects until it 
doesn’t get messed up. It’s very 
important to paint properly; for 
every fat object only paint the 
areas of the mesh where the 
object is projected onto.  

CREATE DIFFERENT 
TYPES OF FAT

KNOW YOUR 
 FAT 

ONE BELLY FAT
I duplicate the main body mesh 
and rename it ‘belly effect 
target’. Next I skin wrap it to the 
belly fat object and add it it the 
blend mesh.

5 BUILD THE FAT TISSUES  
With the model complete, it’s now time to build 
out the fat objects. In reality they are connective 
tissues, so they’re on top of muscles and under the 
skin. They are superficial fat tissues that wrap around 
the organs and connect to the skin surface. We can 
model the fat tissues in different ways to get the 
same effect. In this case I build them in sections that 
are shaped like a real fat tissue, so they will behave 
as they would in the real world.

4 CORRECTING ERRORS  
Using Maya’s blendShape node and Set Driven Key 
can deliver great results for most of the model’s 
areas. There’ll be some errors caused by extreme 
movements, so to fix these problem areas, such as the 
shoulder, I’ll use pose space deformation plug-ins such 
as Comet’s poseDeformer (www.comet-cartoons.com/
MELfiles/poseDeformer.html). In my image (above) you 
can see the results, a  character posed with a skeleton, 
muscle objects and a couple of morphs.

3 PREP YOUR MODEL 
I’d recommend using a skeleton model in your 
character before starting to add joints, muscles and 
fat objects. Using a basic skeleton inside the model 
will help you to determine the correct locations of 
joints, and therefore a good pre-sim deformation. You 
want to give yourself as little work to do as possible 
before the simulation, so skin the mesh as perfectly as 
possible. Also, add some corrective shapes to get a 
better deformation before the simulation stage.

6 CREATE AN NCLOTH MESH 
Skin the fat objects to the closest joints, then copy and 
paste the skin from the character body mesh to the fat 
object. This will be the new input object for the fat cloth 
object we’ll add later. Duplicate the object and name it 
‘cloth’. Convert the cloth mesh to an nCloth mesh, then 
connect the attributes using: worldMesh>inoutMesh 
and worldMesh>resetShapeMesh. Key attributes for 
fat cloth mesh are: Self Collide Width Scale, Thickness, 
Stretch, Compress, Input Mesh and Bend.

7 SET DYNAMIC ATTRIBUTES  
For Dynamic Properties, set the attributes like the 
image above (download the image from this issue’s 
online Vault). Paint the input mesh to set where it’s 
stiff and where it’s looser. For example, the inner 
side of the fat objects are connected and stiff, and 
the outer surface is where the fat jiggles so needs 
to be set looser. Go over the whole model and paint 
the input mesh as desired using your judgement.

EXPERT TIP
Check your fat 

If you feel the fat object 
reacts more like a piece of 

cloth then increase 
the Self Collide With 

Scale attribute. It will 
make it more like 

a fat object.
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Duplicate one final time and

name this ‘jiggle mesh’ and 

add all the wrap meshes as

targets of a blendShape node

to this new jiggle mesh

9 SPECIFY THE AFFECTS 
Now start painting the Blend Shape Target Weights 
so you can specify where on the body the effects 
of the jiggle mesh will occur and to what degree 
of intensity. You can also control the values of the 
weights from the Attribute Editor panel. You need 
to play around with this to make it work properly. I 
recommend you cache the fat objects simulation 
because it is easier to paint the Blend Shape Weights 
in real time, and with a good performance.

8 CREATE THE JIGGLE MESH  
Now that you have a mesh with fat objects attached 
and the dynamics set, duplicate the character mesh 
for every one of the fat objects and ‘wrap deformer’ 
them to the fat objects. You will now end up with, for 
example, 10 duplicated character meshes wrapped 
to each one of the fat objects. Once done, duplicate 
one final time and name this ‘jiggle mesh’ and add 
all the wrap meshes as targets of a blendShape node 
to this new jiggle mesh.

EXPERT TIP
Add wrinkles
If you are looking for 
more wrinkles you 
can add more value 
to the stretch and 
compress of the skin 
mesh attributes.

10 SKIN JIGGLES
Turn off the Nucleus node of the nCloth solver, 
then duplicate the character mesh and name 
it ‘skin mesh’. Cache out the jiggle mesh from 
the last step and connect its attributes. You can 
download my menu screens from the online 
Vault for a closer look at the settings. It’s worth 
remembering that a skin mesh is a mesh that you 
can get extra fat jiggles from. This is because 
things like wrinkles add a self-collision effect to 

the skin’s surface. Paint the Input Mesh attribute 
like the image above (again, you can download the 
menu image from the Vault). We do this because 
in fat there are sometimes parts which are looser 
than the rest of the fat object, and this makes it 
look more realistic. Finally, set the attributes of 
the skin mesh like the image here shows (high-
res available in the Vault). Now you can start the 
simulation. 
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MAKE CHANGES 
Adjust the skin mesh  
after simulation
Save out the skin mesh after 
simulation – you should be happy 
with the result at this stage to 
continue. It’s time to correct the 
shapes of the deformations at most 
of the areas after simulation such 
as shoulders, elbows, fat shapes 
and anything else that doesn’t 
look right. Use the Set Driven Key 
as usual for the most part and 
the Pose Deformer plug-in for the 
complex parts. Continue this until 
you’re satisfied with the results.



PART 3: RENDER  
A STILL LIFE SCENE
In the third part of his series, Bhaumik Patel reveals how  
to use translucent materials and Arnold’s skin shader

In the third part of our rendering 
in Arnold series, we’ll look at 
translucent materials using the 

Arnold skin shader and we will be 
creating our grape and cheese 
shaders. These materials all share 
a common property, which is that 
they allow light to pass though 
and light up the object. In CG 
this is referred to as Subsurface 
Scattering or SSS. Just as in our 
last lesson, we should take the 
time to look at real world reference 
in order to recreate it.

Cheese comes in many different 
types but looking at cheddar, 
for example, we see that the 
areas that are thinner have light 
passing through, which is a 
saturated orange. The rest of it 
is a desaturated yellow/orange. 
It also has some shine to it but 
it’s fairly subtle and spread out. 
Green grapes have a lot of light 

passing quite far through them. 
The colour is a saturated yellow/
green in the translucent sections, 
and slightly less saturated on the 
edges. Grapes are quite reflective 
depending on how wet they are 
and there is a variation in the 

sharpness and intensity of the 
reflections and highlights. 

This is a good opportunity to 
create a different image to the  
one I’ve created by looking at 
image references on Google. For 
example, search for cheese and 
you will get a variety of different 
looks to recreate. 

Displacement mapping will add  
polygons to your object, to 
describe the detail in your 
displacement texture. This can 
slow down your render time so  
I would therefore advise you to  
use it sparingly.

We will also create a procedural 
displacement map to create detail 
in the cheese wedge. It will be a 
3D marble texture, so no UVs will 
be required.

All the files you need to follow 
my tutorial are in the online Vault. 

For all the assets you need go to        
creativebloq.com/vault/204 

ARNOLD FOR MAYA PLUG-IN

TOPICS COVERED
Arnold shaders
Subsurface scattering
Reflections

Grapes are quite reflective depending on how wet 

they are and there is a variation in the sharpness

and intensity of the reflections and highlights 

FOLLOW
THE VIDEO

If you see the Play icon,
use the link!
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SHAPE NODE 
Use Displacement Attributes
In the Arnold section of your 
object’s Shape node, you can 
find Displacement Attributes. 
The Height parameter will allow 
you to scale the amount of 
displacement. Displacements can 
sometimes be clipped if they are 
larger than the bounding box of 
the object, so increase Bounds 
Padding to fix any clipping. Scalar 
Zero Value allows you to set 
which value has no effect, for 
example 0.5 would mean grey 
would do nothing, white would 
come up and black down.

4 REFINE THE REFLECTIONS
Now let’s adjust the reflections on our grapes by 
going to Shader>Specular and set the weight to 
0.7. This will make the reflections less intense. You 
can increase the roughness to make the reflections 
appear broader and less shiny, too. Notice there 
is grain in the new materials; you can improve 
this by increasing samples once you’ve finished 
fine tuning by going to Render Settings>Arnold 
Renderer>Sampling>SSS section.

6 TEXTURE TWEAKS
By default, our texture displaces the surface 
outwards. In order to displace inwards we will need 
to adjust the Alpha Offset to -0.8. This will make 
the texture negative. Now let’s scale the marble 
3D texture placement to 3 to scale the pattern up. 
Arnold displacement attributes are located in the 
Shape node of your object. Be sure to smooth your 
object to get the best results. 

3 CHECK AND ADJUST
Now it’s too translucent and the grapes look 
like balloons! This is easily fixed by adjusting the 
Deep Scatter Radius to 0.4. This will bring some 
shadows back into the grapes. Continue tweaking by 
adjusting the Radius and Weight until you are happy 
with the results. The IPR may be too slow to give 
interactive feedback, so be sure your light samples 
are set to 1. You can render regions for better  
quality feedback, too.

5 USING HYPERSHADE
Open Window>Rendering Editors>Hypershade and 
select the cheese shader and duplicate it using the 
Edit>Duplicate command from the main menu.  
Rename it ‘cheese_wedge_shader’ and apply it to  
the cheese wedge object. Select Hypershade> 
Graph>Output Connections and double-click the 
shading group for your cheese_wedge shader. Map 
displacement with a Marble texture from the 3D 
textures section. Set the vein colour to black.

1 SET UP THE CHEESE
Select the Cheese Cube objects then right-click and 
select Assign New Material. Create an aiSkin shader 
from the Arnold section. Rename it ‘cheese_shader’ 
and start an IPR session. Let’s change the colours 
in the Shallow, Mid and Deep Scatter section. Let’s 
also change the Radius Multiplier to 1.5, as this will 
enable the scatter to travel further. It’s a bit too shiny, 
however, so let’s tweak this by lowering the reflection 
weight to around 0.6.

2 SET THE GRAPE MATERIAL
Select the Grape objects, right-click and select Assign 
New Material. Create an aiSkin shader and rename it 
‘grape_shader’. Change the SSS colours by changing 
the Shallow Scatter\Mid Scatter\Deep Scatter to 
a yellow-green. Be sure to look at references when 
making colour changes. At the moment our grapes 
look like olives because they appear dense, so 
increase the amount the light that can travel through 
by increasing the Radius Multiplier to about 10.

USE REFERENCES
It’s really important to 
source some reference 
material and refer back to 
this in order to ensure the 
colour changes you are 
making are correct 

GOOD DISPLACEMENT
Smooth your object 
for good displacement 
results. In the shape node 
of the Cheese>Arnold> 
Subdivision>Type change 
cat-clark and set  
iterations to 2

FOLLOW 

BHAUMIK’S FINAL

ARNOLD TUTORIAL

 Issue 205, on sale 27 January

CLICK TO PLAY VIDEO
www.bit.ly/204-render
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CREATING CLOUDS WITH 
PHOENIX AND V-RAY
Alex Farrell explains how to create realistic 3D  
clouds suitable for viewing from all angles

It’s probably safe to assume that 
JJ Abrams’ new Star Wars film 
will create a new set of iconic 

characters and locations for fans 
old and new. Perhaps one of the 
most memorable locations from 
the original saga was Cloud City, 
a mining colony that floats 60,000 
kilometres above the planet of 
Bespin. Cloud City proves to be a 
pivotal location in the original Star 
Wars saga, playing host to several 
key heroes and villains.

The purpose of this tutorial 
is to introduce Phoenix FD to a 
wide audience and demonstrate 
its power. We’ll be using it to 
create the clouds that Cloud City 
sits amongst. There are several 
advantages to using Phoenix FD  
as opposed to other fluid 
simulation engines. Namely that 

it has been developed by Chaos 
Group, which means it works well 
in tandem with their most popular 
piece of software: the render 
engine V-Ray.

We will also cover the 
modelling of Cloud City itself, 
and go through some simple 
techniques which will make 
creating an entire city much 
easier than it initially sounds!  

We’ll be taking inspiration for 
the design of Cloud City from 
the concept sketches of Ralph 
McQuarrie. His work is largely 
responsible for the look and 
feel of the original Star Wars 
trilogy. In fact, an early concept 
of Cloud City envisaged it as a 
prison from where Princess Leia 
would be rescued. The version 
in this tutorial will be closer in 

appearance to the industrial feel 
sketched by Ralph McQuarrie, 
as opposed to the more elegant 
look in The Empire Strikes Back.

The types of cloud we will 
be creating are known as 
stratocumulus. It’s’s important 
to take note of their shape and 
density. Despite their reputation 
of being light and fluffy, clouds 
can be surprisingly dense. If we 
look at the areas in direct sunlight 
and the areas in shade, we can 
see how much light is being 
soaked in and blocked by the 
cloud. They also tend to have 
flat bottoms but a more billowy 
shape on top.

So without further delay, let’s 
get started with the tutorial. 

For all the assets you need, go to        
creativebloq.com/vault/3dw204 

3DS MAX | V-RAY | PHOENIX FD | PHOTOSHOP

TOPICS COVERED
Modelling
Complex map creation
Lighting and rendering
Post production

ARTIST PROFILE
Alex Farrell
Alex is a 3D artist at 
The Neighbourhood, 
working predominantly 
in architectural 
visualisation. He also 
produces visual effects 
for TV commercials  
and brand campaigns.
thinkinimages.co.uk

IN THE CLOUDS
Alex demonstrates how to 

make clouds look good  
from every angle 

FOLLOW
THE VIDEO

If you see the Play icon,
use the link!
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By changing the

Phase value this 

will generate a

different formation 

of clouds

EXPERT TIP
Object Interaction  
with Phoenix
By default, objects inside 
the PHXSimulator grid will 
interact with the simulation. 
Use the Preview tab to 
exclude any unwanted 
interactions with 
geometry and forces.

4 CLOUD COVER PLANE
Save your current scene and create a new one, 
retaining the System Units setting of Centimetres. 
Create a plane with Length and Width at 25 metres, 
and both Length and Width Segs to 1. Set the name 
to ‘EmitterPlane’ so we can easily identify it later on.  
With the plane selected right-click and select Object 
Properties, uncheck the Renderable property. In the 
Material Editor [M] create a new VRayMtl and call it 
‘DistributionMtl’, then apply this to EmitterPlane.

2 UNITS AND SCALE
Despite the fact we will be creating a vast scene that 
stretches for miles, we will be working in centimetres. 
Go to Customize>Units Setup>System Units 
Setup and ensure that Centimetres are selected.  
When working on separate elements of the shot in 
individual files, it is important to keep the units the 
same throughout. This will make the merging of 
objects a pain-free process, and ensure that settings 
for maps and simulation controls remain consistent.

3 BLOCKING IT OUT
Phoenix grids can be scaled and transformed post 
simulation, so we don’t have to worry about their 
exact proportions. Nor will we be modelling Cloud 
City at its actual size, as this will lead to issues with the 
V-Ray render engine. Create simple box primitives as 
your cloud volumes. To quickly toggle transparency 
make use of 3ds Max’s See Through mode (hold 
[Alt]+[X]). Create a Sphere to represent the c, and 
similar primitives to represent a foreground element.

1 COMPOSITION REFERENCE
We will be tackling an external view of Cloud City, 
placing it in context of the surrounding clouds. 
We will also require a foreground element to create 
depth and give an impression of grand scale. For 
this I will be using a Storm IV Twin-Pod Cloud Car, 
but an X-Wing or TIE Fighter would suffice! When 
constructing my composition I consulted the 
Golden Spiral to help place my foreground, mid, 
and distant components.

CONSISTENCY IS KEY
It’s important to 
remember when working 
in individual files to keep 
the units the same  

5 GRADIENT AND RADIAL MAPS
In the Diffuse slot of DistributionMtl add a Gradient 
map. Set the Color 2 Position to 0.2 and Gradient 
Type to Radial. In the Noise parameters set the 
Amount to 0.6 and the Noise Type to Turbulence. 
This map will control the distribution of particles 
created by our Phoenix simulation. The purpose of 
the Radial map is to prevent white areas appearing 
at the edge of our plane, where high quantities of 
particles are not wanted.

7 NOISE MAP 
Create a Noise map in the Color #2 slot of the 
Gradient map and set Source to Explicit Map 
Channel. In the Noise parameters set Type to 
Turbulence and Size to 0.2. Set High to 0.45, Low to 
0.22, Levels to 6.0, and Phase to 6.2. By changing the 
Phase value this will generate a different formation of 
clouds. Click Go To Parent, copy the newly created 
Noise map and then paste into the Color #3 slot as 
an Instance. 
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PHOENIX INTERACTION 
Using Geometry and Forces
By default, Phoenix particles will 
interact with any object that is 
present in the PHXSimulator, at 
no cost to performance. Similarly, 
any Forces that are present in the 
scene will be viewed as an Active 
Force by Phoenix. All of 3ds Max’s 
standard Forces are supported 
by Phoenix. You can change 
this default interaction type by 
going to your PHXSimulator 
and opening the Interaction 
panel. Clicking the Include List 
radio button will make Phoenix 
ignore any objects present in the 
simulator, unless they are added 
individually using the Add  
button below.

CACHE PATHS 
By default, when we 
save a new iteration, 

the simulation files 
are copied to an 

implicit path

12 MODELLING CLOUD CITY
In a new scene create a box with a Length and 
Width of 500m and a Height of 350m. Hold [Alt]+[X] 
to make it transparent – this will be a visual guide 
for the size of our city. In the left Viewport create 
a line that traces the side profile of Cloud City. 
Add a Lathe modifier with 96 Segments and check 
Weld Core. Use the same technique to quickly and 
efficiently model the towers that populate the city.

9 SIMULATOR AND TURBULENCE
In the top Viewport create a PHXSimulator that  
covers EmitterPlane. In the left Viewport align the 
base of the simulator to the plane and give it a  
height of 1.2 metres, using a box as a quick  
measuring tool. Also create a PHXTurbulence object  
in the scene, with a size of 5m. Set Last Stage Amp  
to 0.13, and Multiplier to 100. Back in the  
PHXSimulator go to Output and set the Cache Path  
to a local directory.

8 PHOENIX SETUP
Create a PHXSource object next to EmitterPlane. 
Click Add then click on EmitterPlane so it is listed as 
an Emitter Node. Click Auto Key [N], on Frame 0 set 
Discharge to 100, at Frame 10 set to 100, and finally 
on Frame 11 set to 0. Then toggle Auto Key mode 
off. Set Temperature to 200, Smoke to 3.0, check 
Multiply by Velocity, and set Velocity to 0.2. Copy 
and paste the Gradient map into the Smoke Map as 
an Instance. 

11 RENDERING PHOENIX
In the Rendering tab set Surface to Smoke, click 
Colors and Transparency to open the Render 
Parameters window. In the Fire panel set Based on 
to Disabled. In the Smoke Color panel set Simple 
Color to a value of 223,223,223. In the Smoke 
Density set Based on to Smoke, and the Simple 
Smoke Factor to 0.15. Open the Time Configuration 
window and set the End Time to 60. In the 
Simulation tab hit Start When Ready.

10 PHOENIX SETTINGS
In the Dynamics tab uncheck the Vorticity xV 
checkbox and set the value to 0.15, set the Smoke 
Dissipation to 0.1 and Randomize Amount to 0.05. 
Change the Conservation method to Smooth and 
the Quality to 30. Change the Steps per Frame value 
from 2.0 to 1.0. In the Grid tab, use the Increase 
and Decrease Resolution buttons to control the 
number of cells in the simulation. My final production 
simulation had 95 million cells.

13 MATERIAL IDS
Add an Edit Poly modifier to Cloud City and use the 
Extrude tool to push polygons inwards. Set the IDs of 
these polygons to values between 2 and 10, keeping 
adjacent polys the same. In the Material Editor create 
a Multi/Sub-Object and create a VRayMtl in the 
second Sub Material slot. Source or create seamless 
textures of high-rise glass buildings at night. Add the 
texture to both the Diffuse and Self-Illumination slots 
of the material, repeat for slots 3-10.
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TWO BLUR THE SELECTION
Fill the selected area with white 
and deselect by holding[Ctrl]+[D]. 
Go to Filter>Blur>Gaussian Blur 
and set Radius to 80. Click OK.

THREE BLENDING MODE
Change the Blending Mode 
to Screen, and reduce the Fill 
property to suit. Use a Soft Eraser 
brush [E] if the effect is too 
strong in areas.

CREATING FAKE  
GOD RAYS

POST  
PRODUCTION 

TIP

ONE SELECT THE AREA
Using the Polygonal Lasso tool 
[L], create long rectangles that 
originate from the main light 
source and move across the 
image – preferably crossing 
through shaded areas.

18 RENDER ELEMENTS
In the Render Setup Window [F10], select the 
Render Elements tab and click Add. Select the 
elements you usually use in post production. I 
added VRayGlobalIllumination, VRayNormals, 
VRayRawLighting, VRayRaeReflection, 
VRayRawRefraction, VRaySelfIllumination, 
VRaySpecular, VRayWireColor, and a 
MultiMatteElement. In the MultiMatte element 
ensure that MatID is checked on.

19 LIGHTS AND CAMERAS
Position the Perspective View to the angle you 
wish to render from. Select V-Ray Physical Camera 
from the V-Ray Toolbar and press [Ctrl]+[C] so it 
matches the Perspective View. Press [C] and the 
Viewport will be set to the Camera, as opposed to 
Perspective. Select the newly created camera and 
set the F-Number to 12, White Balance to Neutral, 
and Shutter Speed to 120. Create a VRaySun in the 
scene, choosing Yes when prompted.

EXPERT TIP
Phoenix render  
elements
Your Phoenix simulation 
will appear in both the 
VRayRawLighting and 
VRayAtmosphere render 
elements. Useful for when 
you want to isolate the 
simulation, but render 
alongside geometry.

15 TWIN-POD MODELLING
The schematics for the Storm IV Twin-Pod are available 
online, so use these as a guide when poly modelling. 
To add detail, create seams that divide the vehicle into 
what appears to be separate panels. To create these, 
select an Edge and click Loop. Open the Extrude 
Settings window, set the Height to -2cm and the Width 
to 0.25cm. Create additional edge loops alongside this 
newly created crevice. This will ensure the gap remains 
small when a Turbosmooth modifier is added.

14 CITY BASE MATERIAL
In slot #1 of the Multi/Sub-Object create a VRayMtl 
with a Diffuse RGB value of 54,54,54. Set Reflection 
Subdivs to 24 and RGlossiness to 0.8. Add a Falloff 
map to the Reflection slot. Change both strength 
values from 100 to 50. Instance a Noise map to both 
slots, set Noise Type to Fractal,  size to 400, Levels 
to 8, High to .835 and Low to 0.44. Set Color #1 to 
29,29,29, and Color #2 to 46,46,46.

17 PAINT MATERIAL CONTINUED
Click the VRayMtl button and choose 
VRayBlendMtl. Choose the Keep Old Material as 
Sub Material option. In the first Coat slot add a 
new VRayMtl, set the Diffuse to an RGB value of 
209,38,0, and the Reflect Colour to 245,245,245. Set 
the RGlossiness to 0.99 and Subdivs to 32. Uncheck 
the Fresnel IOR lock and set the value to 2.0. 
Change the Material ID Channel from 0 to 1, so we 
can select this easily in post production.

16 PAINT MATERIAL
Create a VRayMtl, add a VRayDirt map to the 
Diffuse and set the Occluded Color to Black and the 
Unoccluded Color to 205,27,0. Set both Distribution 
and Falloff to 0.4, and Radius to 0.2m. Set the 
Reflection Colour to 229,62,35, and the RGlossiness 
to 0.78. Uncheck the Fresnel IOR lock and set the 
Value to 4. Set the Reflection Subdivs to 32. In the 
BRDF panel change Phong to Blinn.

CLICK TO PLAY VIDEO
www.bit.ly/204-bespin
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TWO ADD A LIGHT
In the PHXSimulator go to the 
Preview panel, click the None 
button, then select the key light. 
For clouds this is usually the sun.

THREE SELECT PREVIEW ANGLE
Select the viewport you wish to 
preview your simulation in. It will 
be mirrored in the GPU Preview.

GETTING INSTANT  
FEEDBACK

PREVIEW
 SIMULATIONS

ONE CHANGE THE VIEWPORT
In a spare viewport, click the 
name of the viewport in the top 
left. Then go and select  
Extended Viewports>PhoenixFD 
GPU Preview.

20 RENDER SETTINGS
For the non-Phoenix elements, go to the V-Ray 
Render Settings, and in the Image Sampler panel 
set Type to Adaptive, Min Shading Rate to 2, and the 
Image Filter Type to VRayLanczosFilter. Set the Min 
and Max Subdivs to 1 and 24, with a Color Threshold 
value of 0.005. Enable GI, set the Primary Engine 
to Brute Force, and the Secondary Engine to Light 
Cache.  In the Common panel, set the Output Size  
to 4096x2304.

21 RENDERING PHOENIX
Isolate the Phoenix Elements by hiding any 
geometry. Raise the Color Threshold to a value of 
0.01. PhoenixFD is less dependent on this value 
than regular geometry, so we can afford to raise it 
fairly highly. In the Settings panel set the Dynamic 
Memory Limit to a number close to your system limit. 
For example, for a machine with 16Gb of RAM, set 
this number to 14000 and for a machine with 8Gb of 
RAM, set this to 6000.

23 REFLECT AND ILLUMINATE
Add both VRayRawReflection and 
VRaySelfIllumination passes to your PSD and  
set both Blending Modes to Screen. This tells 
Photoshop to ignore the dark areas of the image and 
boost the brighter areas. Play with the Fill properties 
until you achieve the desired result. I found that 65 
per cent of the Illumination pass, and 50 per cent for 
the Reflection pass worked well for me.

22 ASSEMBLING THE PSD
Add the render containing Cloud City to the base 
of your PSD. Secondly, add the Phoenix render 
on top. When saving renders as EXRs the alpha 
is embedded into the file. To mask the clouds 
move the alpha to the top of the stack, go to 
the Channels tab and hold [Ctrl]-click the RGB 
Channel thumbnail. Back in the Layers tab, hide 
the alpha layer, select the layer you wish to mask 
and click Add Layer Mask.

EXPERT TIP
Quickly access 

primitives
In addition to the standard 

right-click menu, other 
quad-menus can be 

accessed by holding down a 
modifier key. Press [Ctrl] to 

bring up the Primitives 
and Transforms menu.

24 VIGNETTING
Add a Curves adjustment layer at the top of the 
PSD, and set the Blending Mode to Multiply. Click 
the Layer Mask thumbnail and invert it by holding 
[Ctrl]+[I]. Select the Brush Tool [B] and choose a 
large brush with a Hardness value of 0 per cent. 
Paint around the edges of the image to darken 
them; this works more effectively than painting a 
black colour over the top as we are burning the 
RGB values and retaining the saturation.

25 COLOUR GRADING
Colour Lookup Tables (LUTs) can be useful to test out 
different grades for your image. Add a Colour Lookup 
adjustment layer and click the Menu which currently 
reads Load 3D LUT. Photoshop ships with a set of 
in-built LUTs, but more can be purchased or sourced 
online. The Kodak and Fuji LUTs emulate the colours 
that would be produced on real-world film, whereas 
DropBlues.3dl produces a particularly striking black 
and white effect across the majority of the image.
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NEW WORKFLOW
Combine Marvelous 

Designer and ZBrush to 
create realistic cloth

DISCOVER A NEW WAY 
TO CREATE CLOTHING
Jingtian Li reveals a new way to create realistic cloth by 
combining Marvelous Designer and ZBrush

We already know that 
ZBrush is a powerful tool 
for creating organic and 

complex shapes, like clothes. But 
it may take a lot of tweaking and 
reference to eventually make the 
cloth look natural and believable, 
and this is time consuming, too. 
In this case, we are going to learn 
a new workflow that uses cloth 
simulation to create the basic 
shapes, and then migrate to 
ZBrush to do some tweaking and 
add some detail.

Marvelous Design is a design 
tool for fashion. It not only  
provides the general workflow for 
designing cloth, but also gives 
unbelievably fast and realistic 
cloth simulation that can fulfil any 
static model or animation. The 
workflow in Marvelous Designer is 
very unique; instead of modelling 

a cloth or importing a cloth 
geometry from another package, 
we can create cloth patterns, sew 
them together, and simulate them 
using dynamic – in the same way 
people create patterns for clothes 
and sew them together in the 
real world. Using this workflow, it 
makes the creation process easier 
and faster, as well as making the 
end result more realistic.

ZBrush is one of the most 
popular 3D sculpting tools 
which can create any figure from 
scratch by using its very flexible 
workflow, brushes and tools. We 
can use ZBrush to do any tweaks 
we want after getting a very nice 
base mesh from our Marvelous 
Designer simulation.

Before we start this tutorial, you 
should know that no matter what 
tool we are using and however 
a realistic we are going for, it’s 
always good to judge things with 
an artistic eye – always think of 
the concepts of art first. Never 
let dynamic simulation determine 
everything for you; trying to find 
the right composition, contrast, 
and variation are more important.

The version of Marvelous 
Designer we use is 5, and any 
version of ZBrush 4 will work for 
this tutorial.

For all the assets you need go to  
creativebloq.com/vault/3dw204

MARVELOUS DESIGNER 5 | ZBRUSH 4R6

TOPICS COVERED
Cloth simulation
Detailing

76 3D WORLD  February 2016 www.youtube.com/3dworld

TUTORIALS
Create believable cloth

ARTIST PROFILE
Jingtian Li
Jingtian is assistant 
professor at the 
University of the 
Incarnate World. He 
is a 3D generalist and 
particularly enjoys 
character modelling.
www.tiansart.com



2 IMPORT THE MESH  
After exporting the mesh, open Marvelous Designer. 
Go to File>New to create a new scene, then File> 
Import>OBJ, select our body mesh and import it. 
Marvelous Designer will treat the grid as a ground 
plane, and the cloth will actually collide with it. In this 
case we want to disable it because the body is below 
the grid. Go to Preferences>Simulation Properties and 
uncheck the Collision of the ground property. You can 
change the height of the ground with the Height value.

4 ALIGN IN 3D VIEW
Select the Curve tool and drag on the edges to 
convert straight lines to curves. Repeat this to 
finish all the basic patterns on the one side. They 
will be placed into the 3D view on the left side 
automatically. Now select the patterns and move 
them to the location close to where they should be in 
the 3D view, to make the simulation easier.

1 EXPORT THE BODY MESH
After you have the body finished in ZBrush, select 
the mesh and go to Tool>ZRemesher. ZBrush will 
then change your body geometry to a low poly. 
Select Export in the Tool palette to export it, and 
use .obj file as the file format. After that we can press 
[Ctrl]+[Z] to get our detailed model back. We don’t 
really need to worry about the face being a little bit 
misfigured, as we only need the right body shape.

3 CREATE CLOTH PATTERNS
On the right side, there is a 3D view that looks like a 
UV editor. We need to use the Polygon tool to draw 
patterns in this 2D viewer. To create cloth patterns, 
we can use the Edit Pattern tool (by pressing Z), 
to change the shapes of the patterns. For realistic 
purposes, you should find some actual cloth designs 
to see how the patterns would look in the real world, 
and then replicate these.

5 MIRROR AND SEW
To mirror the pattern on the other side, select 
everything in the 2D view and press [Ctrl]+[C],  
then right-click to chose Symmetric Paste. This will  
allow you to create the other side. After I am happy 
with the patterns, I use the Segment Sewing tool 
and Free Sewing tool to sew the patterns together. I 
ensure the sewing direction is right by looking at  
the lines in the 3D view. Sometimes they may  
end up reversed.

6 TIME FOR THE SIMULATION
Press the Space button to start the simulation. I’m 
happy with the early result of the simulation, but it 
can be refined. You can change the shapes of the 
patterns while it’s simulating to have an interactive 
feedback. Drag any point on the cloth in the 3D 
view to interact with it. In this particular situation, I 
need to drag the sleeves up.
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ADJUSTMENTS  
Get the right scale
If you take a look at the scale of 
the body of the default scene and 
compare it to the scale of the grid, 
you should get a good idea of 
how big your own body geometry 
should be. Make sure it’s the 
same scale, and if not, you have 
to type the right scale value into 
the Import OBJ pop-up menu to 
compensate for the difference.

SEWING TIPS   
Do it the right way
When using Marvelous Designer 
you need to approach approach 
patterns in the same as if you were 
creating them in the real life. When 
you start to sew in Marvelous 
Designer learn the constraints of 
the tools. The Segment Sewing 
tool only allows you to sew two 
complete edges, while the Free 
Sewing tool allows you to sew from 
anywhere on any edge to any area 
on any edge, or multiple edges by 
holding [Shift]. 

I also like to change the colour 
of the fabric in Marvelous Designer 
when creating a pattern. You can 
change the colour of the default 
fabric by going to the Fabric tab 
on the right-hand side and make it 
darker, so that it’s clearer to see.



FREEZE THE   
PERFECT PARTS

If you are happy with 
some parts and don’t 

want to change them, 
then freeze them. To do 
this, select the patterns, 

right-click in the 3D view 
and choose Freeze. The 

colour will turn blue

KEEP THE NORMAL RIGHT
Make sure that the normal 

of the patterns are facing 
the same direction. As you 

can see, the collar flips 
out and the colour of the 

backside is a little bit dark – 
that’s what you should get

10 OTHER SMALL PARTS
Now it’s time to create the collar. To save simulation 
time, select everything and freeze it. I created three 
pieces for the collar to get the desired result. Now 
click Add in the Fabric tab to create a new fabric. Go to 
Physical Property and change the preset to S_Collar_
with_Interlining_CLO_V2. Select the patterns of the 
collar and change their fabric to the new fabric we just 
created, which is FABRIC_1. This makes them harder, 
and also easier to control. Press Space to simulate it.

9 USING PRESETS
We can also go to the Fabric tab and select the 
default_Fabric. In the Property Editor, change the 
Preset under Physical Properties to a D_Denim_
CLO_v2. You can choose whatever type you want 
and see how it behaves. After you are happy with 
the shapes, you can lower the particle distance of 
the cloth to five, to see more precision. The step 
image on the left shows what I finally got for the 
cloth wrinkle once the presets were changed.

8 DYNAMIC QUALITY
To raise the simulation quality, select all the patches 
and go to Property editor>Simulation and change 
the particle distance to a smaller value – I use 10. If 
you simulate again, you will see the precision greatly 
improves. But keep experimenting until you achieve 
the results you want.

11 FINISH THE REST
I use the same technique I used to make the shirt 
collar to create the folder cuff style ends of the 
sleeves. The final result looks like this (above). When 
creating these sleeves, make sure all the normals are 
consistent; that the normal of the patterns are facing 
the same direction. Otherwise it will not be shown 
properly, or simulated correctly.

7 ONE SPECIAL PART
Notice that in my ZBrush model, the bottom of her 
shirt is actually stuck inside the belt. In order to 
achieve this I need to draw some lines inside the 
cloth pattern using the Internal Polygon/Line tool 
(press G). I then need to make those lines elastic by 
selecting the lines and going to the Property editor 
and ticking Elastic.
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17 ADJUST THE THICKNESS
Finally, go to Tool>Morph Target and press StoreMT. 
Then go to Tool>Deformation and move the Inflate 
slider up a little. How far you move it will determine 
how thick the cloth is. Go to Tool>Morph Target and 
press CreateDiff Mesh. This will create a new ZTool in 
the ZTool list within the Tool palette. To get it into our 
subtool, go to Tool>Subtool>Append and select the 
last ZTool from the quick pick section. Now we should 
have a finished cloth that has a thickness. 

16 BUMPNESS AND TEXTURE
Click on BrushAlpha on the right side of the toolbar, 
then select Import and load in a grayscale cloth 
texture. Do the same thing for the Texture below. 
Then go to Tool>Texture Map and select the cloth 
texture we imported. Go to Displacement Map 
just below the Texture Map palette, and select the 
same texture. Press Mode, and then change the 
intensity to 0.005.

Move the Inflate slider up a

little. How far you move 

it will determine how

thick the cloth is 

12 EXPORT YOUR CLOTH
Select all the patches and then go to 3D Garment> 
Quadrangulate in order to make them all quads. 
Then go to File>Export and select OBJ. If you get 
a wrong scale when you import it into ZBrush, just 
change the scale value. It should be valued like 1 or 
10,000, depending on whether it’s too big or too 
small. Press OK to finish the export.

15 ZBRUSH REFINEMENTS
To refine ZBrush press [Ctr]l+[D] to subdivide it 
three times. Now press [B] and the Brush menu will 
pop up. Press [S] to isolate brushes that have the 
letter S in their name, then find Dam_ Standard and 
go to Stroke>Lazy Mouse>LazyRadius and change 
the value to 50. With Lazy Mouse, we can start to 
enhance the edge of the folds by drawing strokes 
along their edges. You only need to enhance some 
of the important folds, not all of them.

14 POLYGROUPS
Go to Tool>Polygroups and press UV Groups. This 
will create Polygroups for each individual pattern we 
have created in Marvelous Designer. This is because 
Marvelous Designer actually creates individual 
UV islands for every pattern, which makes further 
sculpting much easier.

EXPERT TIP
Repeat UV
If working on texture  
and displacement 
maps, go to the UV 
Map Palette and 
increase the value of 
Hrepeat and Vrepeat 
to tile the texture.

13 IMPORT TO ZBRUSH
Now go to ZBrush, go to Tool>SubTool>Append,
select a sphere, and then select the
sphere subtool by holding alt and click on it
in the viewport, go to Tool>Import, find the
.obj file we exported, and press Open, the
exact cloth geometry should be imported.
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CREATE A PHOTOREAL
CHARACTER RENDER 
Marko Ivanovic guides you through the process of texturing, shading and 
rendering a sci-fi character using Substance Painter, V-Ray and 3ds Max

Since that first screen 
engulfing shot of the Star 
Destroyer looming over our 

heads, Star Wars has inspired 
generations of artists. This movie 
changed the way we perceive 
science fiction. Through six films 
we have witnessed countless 
memorable moments and were 
introduced to some of the most 
iconic fictional characters in movie 
history. Now The Force Awakens 
is out and we finally get a long-
awaited sequel to the original Star 
Wars trilogy, I was inspired to draw 
on my love of the series and create 
my take on Boba Fett.

In this tutorial I will introduce 
you to my workflow for creating 
photorealistic textures and 
materials, and setting up a 

scene for rendering. I will also be 
showing you how to achieve a 
cinematic and photorealistic look 
in your renders. 

Boba Fett and other characters 
have quite a damaged and dirty 
appearance, which is important to 
know before starting the texturing 
process. For creating the textures 
I’ll use Substance Painter, as its 
intuitive texturing system – in 
combination with some pre-made 
textures – is perfect for achieving a 
worn, chipped and dirty look that 
would be ideal for this project.

In order to achieve a 
photorealistic and cinematic 
result for my render, I will set up 
the shader, lighting and render 
settings using 3ds Max and V-Ray. 
However, the resulting textures are 

intended to also work perfectly in 
a real-time rendering environment, 
due to Substance Painter’s real-
time and PBR oriented workflow. 
The textures will include a Diffuse/
Color/Albedo map, Roughness/
Glossiness map and height and 
normal map. I will also include the 
process for baking an Ambient 
Occlusion and Curvature map.

In 3ds Max I will show you how 
to set up basic and advanced 
multi-layered materials, how to 
set your render settings for high-
quality output, as well as how to 
set up cinematic lighting, including 
instructions on how to create a 
HDRI environment, with various 
tips and tricks along the way.

For all the assets you need go to  
creativebloq.com/vault/3dw204

SUBSTANCE PAINTER | V-RAY | 3DS MAX

1 GATHERING REFERENCE
At the foundation of every project, there’s a huge bank 
of reference material, and its quality is directly related 
to the quality of the end result. If you’re looking for 
an instant way to drastically increase your skill then 
change the way you approach each project. Spend 
more time focused on studying references and gaining 
an understanding of the subject matter. Every master 
artist knows that skill isn’t measured merely by what 
you know, but by your ability to learn and adapt.

2 UV LAYOUT
When organising your UVs think ahead and organise 
them in a way that will make texturing efficient and 
less of a hassle. Group similar materials into separate 
UV tiles for ease of access and shader assembly. I 
separate Boba Fett into three UV sets: one for the 
metals, one for the clothes, and one for the various 
props that support the character. Each of the three 
groups have similar material properties, so it makes 
sense to group them together.

EXPERT TIP
Don’t be lazy

Keep asking yourself, 
“Could this look any 

better?” Always be your 
own critic, and continue  

to question whether  
your texture, model  

or render could be 
improved.

FOLLOW
THE VIDEO

If you see the Play icon,
use the link!

TOPICS COVERED
Workflow
Texture creation
Materials
Lighting
Rendering
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CLICK TO PLAY VIDEO
www.bit.ly/204-bobba-1



THE FORCE AWAKENS
With the new movie  

in cinemas, Marko 
was inspired to create a 

photoreal render  
of his favourite 

character, Boba Fett 
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4 TEXTURING METAL
To achieve the layered look of Boba Fett’s armour, I 
use several different layers within Substance Painter. 
For the base layer I create a Fill layer and apply a large 
tiled metal diffuse, height and roughness map to their 
slots. These maps are included in the texture pack 
that’s available to download with this tutorial. I also 
add a touch of greasiness by right-clicking the Fill layer 
and selecting Add Filter, then selecting the Grease 
filter and tweaking the settings for subtle effect.

3 COLOUR SEPARATION
My model is based on the original design of Boba 
Fett, which has different layers of paint, marks, and 
so forth. It also has lots of stickers and emblems, and 
different colours on his armour. In order to easily 
access the different parts, I paint and separate each 
painted colour on a different layer. Once done, I save 
each layer as a mask that I will later use to mask out 
the different layers, so I can edit them independently 
and layer them across one another.

6 MASKING THE PAINT
I add the corresponding bitmap mask painted in 
Step 3 to each layer of paint by right-clicking the 
layer and selecting Add Bitmap Mask from the 
pop-up menu. Now I add a generator to the mask by 
right-clicking the mask and selecting Add Generator. 
I then set the layer to Multiply mode. For the 
generator I select MG Metal Edge Wear and tweak 
the settings for realistic results. Finally, I repeat this 
process on each colour layer.

8 TEXTURING CLOTHES
For Boba Fett’s clothes, I add a basic white, soft, 
noisy texture, and paint over large colour and  
value variations to add some depth to the diffuse. 
Once done, I add several layers similar to the rust 
and dust process in Step 7, and spread them in a  
way that looks like dirt rubbed into cloth. Think 
about the types of stains and dirt that might end  
up on a bounty hunter, such as blood, grass, mud 
and grease.

5 ADDING PAINT
I use the colour separation masks I created earlier 
to mask out the different colours of paint to their 
assigned areas. First, I create a white paint material 
by using the paint textures from my texture pack. I 
also add a touch of grease, then duplicate the layer 
several times – equal to the amount of different 
colours on the armour. Like the Grease filter used 
earlier, I add a Fill Overlay layer to each duplicate 
and give it its corresponding colour.

7 ADDING DUST AND RUST
I create two additional Fill layers, one for dust and 
one for rust. For the diffuse I use a generic noisy-
type map. I Add a Fill Multiply layer to each and give 
one a light creamy colour for dust, and the other a 
dark brown colour for rust. I set both layers with a 
high Roughness value to break-up the glossy painted 
look. I add a white mask to the layers and then add 
an MG Dripping Rust generator for rust and MG 
Dust generator for dust.

EXPERT TIP
Avoid generic detail 

When texturing and 
adding detail, avoid a flat, 

noisy and generic look. 
Focus on the contrasts 
between larger details, 

clean areas, and smaller 
details, and create an 

interesting story.
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Baking maps 
Substance Painter uses information 
from various maps (Normal, World-
Space Normal, Ambient Occlusion, 
Curvature) to generate occurrences 
like edge wear, scratches, rust and 
dust. To apply these effects, firstly 
bake additional maps within the 
model: press Bake Textures under 
TextureSet Settings. This opens 
up the settings for baking texture 
maps, where you can choose which 
maps to include. You can select  
the resolution for the additional 
maps, and import a high-poly  
mesh for baking purposes. 
Once baked, Substance Painter 
automatically inserts maps when 
required by certain tools. Also, if 
you prefer, you can import  maps 
baked in an external application.

MASKING TOOLS 
Substance Painter masking
Substance Painter provides you 
with a couple of ways you can mask 
out certain layers. You can add a 
white or black mask as a base mask 
to each layer. Then you can add a 
paint layer on top of the mask fill 
and use several tools to adjust the 
mask. Firstly, you can use regular 
painting with alphas and stencils to 
modify the mask. You can use the 
Projection tool to project certain 
alphas, or you can simulate particles 
with the Physical Projection tool. 
In my opinion, the most useful 
tool for masking is the Geometry 
Decal tool. It allows you to mask by 
topology or continuous topology 
contained in UVs. It allows for easy 
access to isolated objects within a 
single mesh.

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-2

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-3

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-4

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-5

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-6



10 CREATING BASIC MATERIALS
With my textures exported from Substance Painter 
I am going to use them to define certain attributes 
within V-Ray materials. I place the Color map to the 
Diffuse slot, Roughness map to the Roughness and 
Glossiness slots, and Height/Normal to the Bump 
slot. Make sure to invert the Roughness map in the 
Glossiness slot, as it is the opposite of roughness. 
For certain materials like leather, I add a tiled bump 
texture to the Bump slot for micro detail.

9 OTHER MATERIALS
I repeat the same texturing process for the other 
materials such as leather, plastic and glass. I add the 
corresponding tileable texture as a base and work 
on adding wear and dirt layers on top. In the case of 
leather, like with painted metal, I add two layers: the 
first is a masked and generated layer of dark leather, 
which is placed on top of a second lighter leather 
layer to simulate an old and damaged type of  
leather fabric.

12 LIGHTING SET UP
For the lights, I use VRayLights in combination with 
a HDRI lighting environment. To set up an HDRI 
environment I create a VRay Dome Light and in the 
Texture slot of the settings I insert a VRayHDRI map.
Then I browse the HDRI map from within the 
VRayHDRI settings. The way I position my lights 
depends on the mood I wish to have in the final 
image, but usually it’s a three-point lighting set up, 
consisting of a main light, backlight, and fill light.

14 FINAL ADJUSTMENTS
In the VRay Frame Buffer you have several colour 
adjustments available like Exposure, Color Balance 
and Curves. You can also enable Lens Effects like 
Bloom and Glare. I tweak these settings slightly to 
achieve an optimal look and export it to Photoshop. 
I use Photoshop to do my final corrections and also 
use effects options such as Glow, Blur, Sharpening 
and other touch ups, in order to make the image 
look really cinematic. 

EXPERT TIP
Focus on contrasts
When texturing, think  
about the contrasts you 
will create. Add as many 
contrasts in roughness, 
diffuse, and height, but 
maintain the look of  
the material to create  
a dynamic and  
interesting texture.

11 ADVANCED MATERIALS
Sometimes to define complicated attributes it’s 
necessary to use multi-layered materials. I’ll use the 
example of painted metal. I use the standard blend 
material to separate paint from the metal and use the 
Metalicity map from Substance Painter as a mask. I do 
this is to give my metal a stronger reflective value, and 
to give it anisotropic (directionally dependent) values. 
Another common map I use is the Composite map, in 
order to combine multiple maps in a single slot.

13 RENDER SETTINGS
In the GI tab I turn on Enable GI and set primary 
bounces to Brute Force and secondary bounces to 
Light Cache. In the V-Ray tab I first enable the V-Ray 
Frame Buffer, set the image sampler to Adaptive 
and filter to Mitchell-Netravali. For the minimum and 
maximum subdivisions you can use larger numbers 
for better results but this means slower render times. 
In Color Mapping set the type to Reinhard and make 
sure the gamma is at 2.2.
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TWO THICKNESS SCULPT
I mask out both polygroups while 
the other is hidden, leaving the 
polygroup border unmasked, I 
blur the mask and inflate it to 
create a thickness illusion.

THREE PAINT OPACITY MAP
I use PolyPaint to paint out the 
torn area in black, and the cloth 
area in white, so I can use the 
information as an Opacity map.

CREATING  
A TORN CAPE EFFECT

ZBRUSH TIPS

ONE MASK AND POLYGROUP
First, I hand paint a mask on the 
edge of the cape resembling  
the cloth tearing. I press [Ctrl]+ 
[W] to convert the mask into  
a polygroup.

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-7

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-8

CLICK TO PLAY VIDEO
www.bit.ly/204-boba-9
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GET PUBLISHED
EMAIL YOUR CG ART TO
ian.dean@futurenet.com

Visit the online Vault to download  
extra process art for these projects:

www.creativebloq.com/vault/3dw204



TECH INSIGHT

Are studio blockbusters 
advancing the CG industry?

With the global 
blockbuster Star Wars  
storming multiplexes 

across the globe, and all of the 
promotion and fanfare around  
the next instalment that is  
driving massive awareness, 
let’s take a look at some of the 
innovations from the world 
of VFX, VR and AR that the 
studio have used to engage with 
its audience. Is this from an 
entirely marketing perspective, 
or are there other reasons why 
the studio has explored new 
technology and channels, in  
order to further engage their  
loyal fan base? And also, what  
are these uses doing for the  
industry as a whole?

In the lead up to release, Lucasfilm 
ILMxLAB used various new 
technologies to position the 
franchise as a global leader and 
connect with the hardcore fans 
looking for any news or insights 
into The Force Awakens. There 
is no better example of this than 
the first 360 Video for Facebook, 
where you can look-around the 
environment as you speed across 
the Jakku desert. This video was 
exclusively released in partnership 
with Facebook and was used to 
showcase their technology and 
what is possible. 

Due to this first, Star Wars 
received a plethora of news 
coverage across the globe as these 
two famous companies worked 

collaboratively to launch a new 
product, with mutual benefit. Bang, 
PR gold and a marketing coup.

Engaging audiences further
Moving away from the marketing 
benefits that innovation delivers, 
there is a far deeper reason 
why Lucasfilm ILMxLAB have 
invested in new technology and 
initiatives. The world of VR and 
AR offers storytellers a more 
immersive channel to deliver their 
vision to the audience, and the 
audience are crying out for this 
interactive content where they 
can explore the world they love. 
We’ve all dreamed of being C-3PO, 
a stormtrooper, Luke Skywalker 
or maybe even Darth Vader… 

Dr Ian Palmer reveals how CG developments in the  
multiplexes can trickle down to your home setup

AUTHOR PROFILE
Dr Ian Palmer 
Ian develops and 
teaches programmes 
in digital media, 
games, animation 
and VFX. He has a 
doctorate in computer 
animation from the 
University of Sussex, 
having developed 
a new method of 
collision detection  
for real-time 3D objects. 
www.bit.ly/ijpalmer
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a 360 video in 
partnership with 
Facebook, which 
showcased their 
technology and 
connected with 
fans by allowing 
them to look 
around as they 
sped along the 
Jakku desert



Five trickle-down 
developments we’ve all 

benefited from

Prisms & Houdini
In 1985 Kim Davidson 
was hired by Omnibus 
Computer Graphics to 

develop a 3D animation 
software. What began as  

a flight sim software 
for the space shuttle 

evolved into a must-have 
simulation app, and in 

Houdini Indie it’s never 
been more accessible.

Maya
Growing out of Alias 
1 – the software used, 
alongside Softimage, 

by ILM for Terminator 
2 and Jurassic Park – 

Maya is now the staple 
animation tool for VFX 
and animated movies,  

and you’re likely to already 
have it installed.

LightWave
Released in 1990 for the 

Commodore Amiga, 
Video Toaster included 
LightWave, the app was 
used for VFX work on 
Babylon 5 and is now a 
robust and affordable  
set of animation and  

VFX tools.

Unreal Engine
The go-to software for 

game developers has come 
into its own in 2015, with 
sectors from film previz  

to arch-viz and VR 
making the most of  

this powerful real-time 
app. And it’s free  

to everyone.

RenderMan (RIS)
Disney/Pixar’s staple render 

tool has broken free of 
the film industry and been 

retooled for everyone’s 
use. Now easier to use 

than ever, free and packed 
with the same lighting and 
materials used in the latest 

blockbuster animations, 
RenderMan is a must.

TECH

now this is entirely possible as 
we can live stories through the 
eyes of multiple characters and 
perspectives thanks to VR. 

Does this move from the linear 
to dynamic make the director 
redundant? No, it simply changes 
their role and requires them to 
adopt new skills and now craft the 
piece through multiple screens 
and eyes, leaving the final choice 
to the viewer. This choice can 
already be seen in open world 
games like GTA, where the gamer 
can play the game anyway they 
like. They can engage with the 
storyline through missions, they 
can go on a rampage, or they could 
just sit in the car and drive around 
the city listening to the radio. All 

have their merits, but the variety 
open to the user can show real 
depth and immersion. 

This therefore presents an 
opportunity where the creators 
of traditional 90-minute features 
can design extensions where the 
audience can explore in-depth 
different elements of the world 
they are passionate about. The 
storyteller now has the chance to 
develop parallel (complementary) 

threads that can be discovered and 
consumed alongside the traditional 
feature. This engagement brings 
fans even closer, and arguably 
makes them even bigger fans. 

Impact on the Industry
With IPs like Star Wars and the 
enormous content generated 
alongside a theatrical release 
devoured by the audience, an 
opportunity is created to leverage 
and try new technology. As the 
investment in the new technology 
has significant costs, it makes 
complete sense for the larger 
blockbusters to be the ones that 
drive this innovation. After all, 
would you spend the time and 
money creating these in-depth 
worlds if you didn’t 100 per cent 
believe that the audience was there? 

With the environments and 
worlds that are being created 
in uber-realistic fashion, the 
computing power required to 
deliver this is more and more 
demanding, but solutions are 
already being found. At Siggraph 
this year ILMxLab demonstrated 
content being rendered in “the 
cloud” and beamed down to a tablet, 
giving viewers the ability to become 
different characters in a scene with 
classic Star Wars characters. 

In summary, the global 
blockbusters from Star Wars 
through to GTA are driving 
innovation, which over time trickles 
down and becomes available to 
more and more storytellers, creating 
new exciting opportunities for the 
industry as a whole.

FYI
For more information visit  
www.bit.ly/starwars-vr 

We’ve all dreamed of being C-3PO, a stormtrooper or 

maybe even Darth Vader... this is entirely possible as we

can live stories through the eyes of multiple charcters 

Created by Escape Studios, part of 
Pearson College London, the festival 
will run from 23-25 February 2016 
at London’s O2. It brings the best in 
VFX, games, animation and motion 
graphics to industry professionals 
and anyone considering a career in 
visual effects. To find out more, visit: 
www.thevfxfestival.com

THE VFX FESTIVAL
Join fellow passionate artists
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VR and AR allows storytellers  
to deliver interactive content  
to their audiences 



PROJECT INSIGHT

Add depth to your projects

My final shot with 
minimal grain really 
looks much better

Prototyping your 
composites

Use different, 
switchable settings 
for any node while 
experimenting. Just 
choose S1, S2, S3 

and so forth from its 
settings in order to 

swap between  
your setups. 

RAPID  
PROTOTYPINGWith the power of modern 

compositing software 
at our disposal, we can 

start to think differently about 
how we approach our projects. 
In this article I’m going to show 
you how to make the most of your 
renders while keeping hold of your 
creative options for longer. 

Rather than finishing all your 
3D work and rendering out your 
passes ready for compositing in 
Fusion, stop and think about what 
the final shot needs. It may well be 
that you could set up faster renders 
to combine in post, and in some 
cases this will actually help you 
down the line if you need to make 

creative changes. For the example 
I’m using here I have a shot with 
elements in the foreground – to 
aid composition – along with the 
main elements of the shot in the 
mid-ground. Normally I would 
have set up my camera moves, 
sorted any depth of field and then 
left my machine rendering until 
completed, but actually there’s 
a smarter way of doing it which 
works for most jobs.

I’m going to render out my 
scene but without the foreground 
objects, which I will render 
separately. This means that not 
only do I have the ability to adjust 
the placement and framing of the 

foreground elements, but I can 
also use nodes in Fusion to create 
my depth of field. There are a  
few ways of doing that but using 
blur nodes I can create a rack  
focus effect to really help draw  
the viewer into the scene in the 
way I need.

What’s more, all this takes 
far less compute power than 
rendering it all in one pass, with no 
option to adjust in post. 

We will start off simple, so open 
Fusion (it’s free to download from 
www.blackmagicdesign.com) 
and let’s get started.

FYI
For all the assets you need go to  
creativebloq.com/vault/3dw204

Rob Redman shows how to make creative choices  
that will make you work smarter

AUTHOR PROFILE
Rob Redman
Animation and VFX 
industry veteran, 
Rob is often found 
speaking at industry 
events. As well as  
his duties as a 
creative director he 
also runs training 
courses in house or 
on location.
pariahstudios.co.uk
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Once you have your elements in 
place, animated them and so on, 
there are still things you can do to 
help sell the shot. Adding a touch 
of film grain between the Render 
tool and the Saver tool can help 
unify things, and a final colour 
correction to build a look will help 
too. Just try to keep things subtle 
and you won’t go far wrong.

BRING IT ALL TOGETHER
Help get your composites to  
sit more realistically

PROCESS: ADDING DEPTH AND VERSATILITY TO A SHOT
Rob Redman explains how to use Fusion to composite separate passes 

into a dynamic shot you can adapt more easily than a flat render 

ONE GATHER YOUR RESOURCES
The first thing you need to do is get all your files into 
Fusion. The simplest way to do this is to add an LD 
tool from the Common Tools bar near the top of the 
GUI. I add two of these and locate my background 
footage in one and the trees in the other. I also add an 
SV tool so we can save our output.

TWO INITIAL ADJUSTMENTS
Before you get compositing, fix anything that might 
need it. To see the content of a tool grab it and drag it 
into a viewer window. I need a bit of noise reduction 
on my trees but that’s it, as I’ve already balanced my 
background footage in DaVinci Resolve. You can adjust 
with a CC tool if needed.

THREE 3D WORKSPACE
You can do a lot in 2D with this but to make it as 
good as possible let’s add a camera and two image 
plane 3D nodes. Then we need to connect our source 
files to them and adjust so that we have some depth 
to our scene. Check the image to see the node tree – 
it’s simple but effective.

FOUR PLACEMENT IN THE ENVIRONMENT
We need to make sure we have a balance between 
elements, so make sure your image planes are apart in 
zSpace and scaled so the camera sees them. Drag the 
camera into one view and the merge into another, to 
see things properly. I also add a wand mask to my trees 
and use my object buffer as a mask.

FIVE ANIMATING THE CAMERA
The first thing to do here is animate the camera. So 
keeping the same tools in view as before, you can now set 
a start position for the camera. In the settings right click 
the Z Offset and click Animate. Also make sure you set 
your timeline to 120 frames. Go to the end point of your 
timeline and move the camera in the 3D view. Hit play.

SIX ADDED DEPTH AND COLOUR
The motion is fine but the colour is off, so add a CC 
tool between the trees and Blur tool, then adjust until 
happy. Now we can move on to the final part. Add a 
blur to the two image planes. On the first, animate the 
blur amount so the trees start in focus and over the 
animation blur out. Reverse for the background.
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INDUSTRY INTERVIEW

The untold story of making 
Star Wars: A New Hope

Richard Edlund, VFX supervisor on Star Wars: A New Hope shares  
his never-before-heard story of capturing the perfect shot

DEVELOP
Industry interview

AUTHOR PROFILE
Renee Dunlop
Renee is a seasoned 
journalist and 
editor in the VFX 
industry and has 
written the book, 
Production Pipeline 
Fundamentals for 
Film and Games.
www.bit.ly/sw-renee



Star Wars helped launch 
an entire industry worth 
billions today, but it did so 

on a meagre budget and a great 
deal of creativity. Richard Edlund, 
ASC, VES, first cameraman and 
visual effects supervisor, was a 
key member of the first three Star 
Wars films, and in his own words, 
shares some of his experiences 
and achievements of launching a 
multi-billion dollar industry on a 
dime, where something as simple as 
getting from point A to point B is  
an adventure.… 

The journey
“There’s a real good one 
about Guatemala and of 
me taking that shot on 
one of Yavin’s moons” 

says Richard. 
“At first, it was my buddy and 

master machinist Dick Alexander 

and I, but Lorne Peterson (from 
the model shop) decided to take 
a vacation, flew down on his own 
dime and met us there.” Fox also 
hired Pepe Lenzi, who really knew 
how to get around. “He was a…
shepherd? I don’t know exactly 
what to call him. A fixer. He was 
a guy who could figure out how to 
get you in and out of trouble like no 
other human being. He’d be the guy 
who would go to Macao with John 
Wayne and make sure he shows 
up on the set the next day, because 
they’d go out and drink a lot. He 
was Italian but he spoke another 
five or six languages: English, 
Romanian, Spanish, Portuguese 
and Russian. He had worked with 
Federico Fellini and Dino De 
Laurentiis on Nights of Cabiria in 

We were shooting from the sacrificial chamber, long  

ago used for human sacrifices. I found out 

much later about this grisly practice 

1957. He knew exactly how much 
to tip: if you tip too much you are 
a fool and too little they don’t like 
you. He had the magic touch. He 
got us through customs like butter, 
he knew how to grease everybody.”

They arrived in Guatemala City 
with 33 cases of props, equipment, 
and a huge Technirama camera 
with an 8-perf movement and 
powered by a 12 volt car battery 
to use as the plate camera. The 
mercurial Pepe quickly secured 
a truck to carry them and the 
equipment to a second airport 
from which they would fly to 
Tik’al for the shoot. The truck was 
“a Mercedes painted in rainbow 
colours, with dingle balls hanging 
around the windows and a plastic 
Jesus and saints stuck on with glue.” 

The planes to Tik’al were a 
demure olive drab, but far less 
amusing: this vehicle had to fly. 

“They were twin engine WWII 
DC3s used for troop carriers. Ours 
was a tail dragger; it didn’t have 
a nose gear. These were ancient 
airplanes.” On the way, they flew 
over a huge swath cut into the 
jungle. “I asked what that was, and 
they said that was their other DC3 
that didn’t make it.” It was already 
partially reclaimed by the jungle, 
but still visible from the air. The 
only way the dirt runway in Tik’al 
existed was because the airplanes 
took off and landed there all the 
time. Ironically, landing in Tik’al 
“was one of the smoothest I’ve ever 
experienced.” 

Another plane landed: it was a 
turbo prop plane. “Remember, this 
was in early ‘77. In America they 
hadn’t been flying turbo props for 
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In Tik’al, Guatemala, 
Richard prepares the 

shot of a sentry in 
an observation pod, 
with our uniformed 
compadre standing 
in the model shop’s 

tricked out trash can

The final shots in  
A New Hope as we’ve 

all come to know 
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to shoot from the 
tallest Mayan  
ruin at the  
Tik’al acropolis



years.” Once the US deemed a plane 
was too old to be safe, they would 
sell it to Mexico, and when Mexico 
was done with it they would sell 
it to Guatemala. “This beast was 
dripping oil, there was a yard-wide 
puddle under each engine. When 
they started it up, it popped and 
blew the biggest smoke ring we ever 
saw in our life, a 50ft smoke ring 
floating down the runway.” 

The destination
To get the perfect shot, Richard 
wanted to shoot from the tallest 
Mayan ruin he saw at the Tik’al 
acropolis. “The jungle takes over, 
the vines and growth crawl up to 
get closer to the sun, completely 
enshrouding this enormous 

pyramid, and only the very top of 
that ruin had been cleared.” 

With the help of hired workers, 
they hauled the equipment up the 
side of the pyramid and set it all up 
for an early morning shot, “when 
the fog was low over the jungle it 
was really magical looking. We had 
to get there when it was dark, so 
when the sun first came across the 
horizon we’d have a misting jungle.” 

They left the equipment there 
under the protection of a security 
guard, “a guy with a little pistol 
that didn’t need to be there, but we 
hired him anyway” and returned to 
their “luxurious digs, which were 
little thatched roof cottages where 
you’d expect scorpions to come 
marching up on your bed.” They 
had electricity but only bottled 

water. “We drank a lot of El Gato 
beer. The peons, you could only 
pay them about $4 [1970’s value]. If 
you paid them any more they’d get 
totally shitfaced that night and not 
be able to even show up the next 
day. This was something else Pepe 
knew about. But they were good  
workers. And they were just 
mystified by gaffers tape, they 
thought gaffers tape was the most 
fantastic thing they’d ever seen. 
We’d give them a piece and they’d 
stick it on their boots.”

Luckily they showed up in the 
morning and they schlepped their 
way up to the top again, as the 
workers hacked out a path with 
machetes. “There was Pepe and 
Lorne Peterson and Dick Alexander 
and I, that was the crew. We went 
into the little chamber on top. We 
were shooting from the sacrificial 
chamber, long ago used for human 
sacrifices. I found out much later 
about this grisly practice. The 
Mayan priests would stretch the 
victims over a dome-shaped rock 
and whack their chest cavities open 
with an obsidian blade. With one 
big whack they could severe the 
aorta, reach in and pull the heart 
out, still beating, and toss it on a 
pile of other hearts in front of a blue 
statue of their god Quetzlcoatl.”

“Anyway, lo and behold, in the 
dim pre-dawn light, in the middle 
of this chamber, there was a banded 
coral snake that was in the process 

of ingesting a bat. Its jaws had 
expanded and separated, and  
half of the bat wasn’t in yet. It 
wasn’t more than 16in long, but 
these guys are pretty deadly. This 
was our sacrificial animal. One of 
the peons picked up the snake  
with the tip of his machete and 
heaved it out over the edge, back 
into the jungle.”

Richard got his shot and some 
other establishing shots around  
the acropolis. Lorne Peterson 
wound up being the sentry. “It 
was a real beauty. We composited 
several ships flying out of the 
misty jungle, and it was only on 
the screen for four or five seconds, 
maybe, but it made the point.”

FYI
Watch the making of Star Wars: 
www.bit.ly/making-star-wars

We composited several ships flying out of the misty

jungle, and it was only on the screen for four or 

five seconds, maybe, but it made the point
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First cameraman and visual effects supervisor on Star Wars: Episode 
IV - A New Hope, Richard has worked on almost every major movie 
blockbuster since, including Raiders of the Lost Ark, Ghostbusters  
and Die Hard. www.imdb.com/name/nm0249430

IN FOCUS: RICHARD EDLUND 
Projects from the multi-Academy award-winner 



SOFTWARE REVIEW

Akeytsu
PRICE Currently in Beta (free), $16.99 (Learn licence), $79 (Indie licence), $279 (Pro licence)  |  COMPANY Nukeygara  |  WEBSITE www.nukeygara.com

Optimised and 
efficient animation 

workflow

Full FK and IK 
support with no 
extra skeletons 

needed

FBX support for 
Unity and UE4

Cyclemaker helps 
to speed up walk 

and run cycle 
creation

An application 
purely focused on 
animation with no 

filler tools

MAIN 
FEATURES

These days, computer 
animation can be an 
expensive business. Not 

only do you need to shell out your 
hard-earned cash on a decent 
computer, but then you have 
to decide which of the hugely 
expensive animation packages 
you’re going to use in order to bring 
your creations to life.

Fortunately, over the past few 
years we have seen a growing 
trend of smaller, independent 
teams creating more focused 
software. Whether that focus was 
on subdivision surface modelling, 
rendering or animation, the mantra 
remained the same: to give people 
a cheaper, sometimes more refined 
option, which can also streamline 
their workflow.

Among these is newcomer 
Akeytsu from Nukeygara. A 
slick looking program built from 
the ground up, to make the job 
of rigging and animating game 
characters a speedy and  
efficient process.

The version I tested was still 
an early Beta so there were bugs 
present and some features missing, 
but my early impressions were 
positive with the application 
showing some real potential.

Importing and rigging a low 
polygon character, with full IK and 
FK support, was quick and easy 

with the help of the online tutorials, 
and before long I was animating 
using the Spinner, which is an on 
screen control box, and editing 
my F-curves right in the viewport 
with the Curveboard. What’s 
more, creating a simple run or walk 
cycle was helped immensely with 
Cyclemaker, a tool which copies and 
offsets your animation from one 
side to the other.

Unfortunately it’s not all smooth 
sailing. As mentioned earlier, this 
version is aimed more at the Unity 
and Unreal Engine user who wants 
to animate relatively low polygon 
geometry, and for that it’s ideal. 
If you’re looking to do anything 
slightly more advanced then you 
may find the rigging tools a little 
too simplistic.

As an example, there are no 
options to add a twist to help 
rotate the bicep, wrist or thighs. A 
common feature added into most 
rigs to reduce model twisting. You 
also have to select sequential joints, 

like fingers, individually rather 
than having a global control to 
curl and pose them. In fact, there 
are no ‘controls’ to speak of really 
as it’s all joint-based animation. 
Facial animation is also restricted 
to joints as there is currently no 
morph target support.

Skinning your character can  
also be a lengthy process as you 
have to edit the weight values on  
a per vertex level – something  
you wouldn’t want to do on a 
20,000 polygon character. I  
ended up skinning my model in 
another application first, but  
weight painting is on the list of 
additional tools which Nukeygara 
is working on.

With all that in mind you do have 
to remember that we are looking at 
Akeytsu in its infancy. From what  
I hear, the developers plan to 
expand its capabilities to cover 
some of the issues raised above 
and also push it well beyond game 
development and into higher end 
production territory.

But for now though, Akeytsu is  
a fun and focused application  
which achieves what it set out to 
do: to give animators a cheaper,  
but not inferior, option when it 
comes to animating lower end 
game characters.

Akeytsu is a fun and 

focused application 

which achieves what  

it set out to do

VERDICT

WHO ARE NUKEYGARA?

Nukeygara founded in 2014 in Lyon, France by 
Aurélien Charrier and Yannick Rousseau, animation 

and software R&D seasoned professionals, who 
wanted to develop a new vision of 3D animation 

software. Cédric Vidal- Duvernet, an experienced R&D 
developer, joined in spring 2015 as technical lead.

AUTHOR PROFILE
Antony Ward
For over two decades 
Antony Ward, creative 
director at antCGi Ltd, 
has been provoking 
pixels. In that time  
he has worked for  
many top studios and 
also written three 
technical manuals.  
www.antcgi.com
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Akeytsu provides 
animators with 
a cheaper option 
for animating 
lower end game 
characters



SOFTWARE REVIEW

Maxwell Render
PRICE $775  |  COMPANY Next Limit Technologies  |  WEBSITE www.nextlimit.com

Physically-based 
renderer

Multilight

Volumetrics

Particle rendering

Network rendering

MAIN 
FEATURES

I’ve always loved the Maxwell 
Render Engine and yet have 
never used it as part of my 

everyday workflow. For some 
reason it’s never surpassed or 
replaced my love for V-Ray, but  
who knows, that may well change 
in the future.

If you want a render engine 
that is obsessed with doing things 
physically and accurately then 
this is most definitely the solution 
for you. And let me tell you, it is 
excellent at doing that. It focuses on 
light and ensures that it represents 
it as it should. This ensures artists 
can trust it to get incredible photo-
realistic images. 

The other reason they can trust it 
is because of how straightforward 
it is to use. You don’t have to be 
incredibly technical to use it. 
Instead, if you’re an artist who 
knows what a good looking image 
looks like then you’ll get on well 
with Maxwell. Everything is set up 
based on the real world – from the 
lights, all the way to the cameras.

Maxwell is a progressive 
renderer, so if you’re after a solution 
that is going to deliver results 

quickly, then it’s definitely worth 
giving it a try. I find it incredible 
how much quality and detail can 
be calculated in such a short space 
of time; you can make changes and 
see them appear in front of you 
(obviously hardware dependent). 

Getting this level of quality 
is also surprisingly easy to set 
up. They try and stay away from 
stacks of complicated parameters 
and really let you only specify the 
quality and sharpness you want. It’s 
refreshingly simple.

Maxwell has been increasingly 
trying to appeal to a variety 
of different markets including 
architecture and product design, 
as well as film, animation and 
VFX. They provide easy-to-use 
tools that make working in each 

of these industries a job. The 
Multilight feature for architectural 
visualisations is genius and enables 
artists to focus on making creative 
choices, not on long re-renders.  
The attention to real-world 
materials means product 
visualisations stand out as a cut 
above the rest. Massive scene 
handling means that you can use 
it confidently on huge scenes, even 
with complex animations. 

One other thing to note, while on 
the subject of animation, there is no 
flickering! Everything is calculated 
in exactly the same brute force way 
for each frame, so it’s a solution that 
you can rely on.

All in all Maxwell is an excellent 
renderer that should always be 
considered when starting out or 
switching rendering engines. Its 
price point is attractive and it’s 
floating license with render nodes 
makes it even more appealing to 
small studios. They provide a demo 
version of the render suite and I 
would highly recommend giving it 
a few minutes of your time.

Attention to real-world

materials means product 

visualisations stand out

as a cut above the rest 

VERDICT

HISTORY OF MAXWELL RENDER

The very earliest version of Maxwell was released at the end of 2004, after a couple of years  
of internal development. It is a standalone render engine with integrated plug-ins for most 

major 3D/CAD platforms. It is owned by Next Limit Technologies.

AUTHOR PROFILE
Paul Hatton
Paul leads a studio in 
England specialising 
in creating beautiful 
and interactive videos 
and environments.  
He has been working 
in the industry for 
over a decade.  
www.cadesign 
services.co.uk
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One of the many 
advantages with 
Maxwell Render 
is that you don’t 
need to be 
incredibly technical 
to use it – you 
just need to know 
what a good 
image looks like



SOFTWARE REVIEW

Mari 3.0
PRICE £1,221 / $2,013 / 1,463 Plus VAT  |  COMPANY The Foundry  |  WEBSITE www.thefoundry.co.uk

Bespoke texture 
creation for 3D 

models

New nodal system 
compliments 
existing layer 

based workflow

Ability to preview 
models with 

V-Ray, Arnold, 
Unreal and 

Redshift shaders

Modo Preview 
available within 
Mari, along with 
baking toolset

FBX scene import 

MAIN 
FEATURES

Mari has become the 
texture creation tool of 
choice for many artists 

and studios. And with version 3, 
The Foundry are concentrating on 
workflow enhancements.  
   While Mari 2 concentrated on core 
additions with shared channels and 
a raft of productivity tools, Mari 3 is 
concentrating on refining this core 
workflow while adding many new 
enhancements to aid its intolerability 
with other applications. 

A key addition is the inclusion of 
a range of shaders. V-Ray, Arnold, 
Unreal and Redshift are available 
allowing the preview of new texture 
channels in the correct ‘socket’ for 
one of these shader/render engines. 
Married with the new colour 
management tools, previewing 
models while you work for a  
chosen output has never been  
more straightforward. 

The one key omission to the list 
would be Modo, The Foundry’s own 
digital content creation application.
The Foundry haven’t forgotten 
about Modo though; they’ve added 
a dedicated palette to allow Modo’s 

Preview window to appear directly 
in Mari, allowing the artist to 
preview their texture in a production 
grade render engine. The Modo 
Preview can also be used to bake 
textures out directly within Mari.

Having access to so many visual 
methods of previewing texture 
channels makes nasty surprises 
further down the pipeline much less 
of an issue. However, it would have 
been great to see some more render 
engines supported.

Mari 3 can work with OpenSubdiv 
models and subdivide models 
without needing to roundtrip to a 
3D application, which is a boon to 
productivity, as is the ability to use 
Entity Locators to transform, rotate 
and scale objects easily within Mari.

Another great addition is a nodes 
workflow for textures, to work 
instead of, or in conjunction with, the 
existing layer toolset. It handily has 
two modes: one for basic use, another 
for more advanced users. The Node 
view is robust with quick access to 
all adjustment tools and procedurals 
you would get in the Layer paradigm. 

FBX scene import is now well 
supported with the ability to bring 
in cameras and light from your 3D 
software. When tested this worked 
well, although for basic models .obj 
importing is potentially cleaner. 

Mari 3 feels faster, it’s a painless 
upgrade and the new features 
enhance an already great working 
paradigm, rather than the major 
retool as happened from version 1 to 
2 when layers where introduced. 

While a computer with a dedicated 
powerful GPU is a must, even though 
other applications have come into 
the texture creation space, none can 
match Mari’s ease-of-use across 
texture workflows of any size. A solid 
upgrade to this great application.

Other applications have 

come into the texture  

creation space… none can

match Mari’s ease-of-use

VERDICT

AUTHOR PROFILE
Mike Griggs
Polishing pixels since 
1995, Mike is a UK 
based freelance 3D, VFX 
and mograph artist, 
as well as a freelance 
technical writer.  
www.creativebloke.com

MARI HISTORY

Developed in-house at Weta for Avatar, then acquired by The Foundry, Mari was first released in 2010. While 
other applications had allowed painting directly onto models before, Mari’s robust VFX origins and use of GPU 

acceleration offered a never seen before ease of use for texture and 3D artists.
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Mari 3 offers a 
built-in Modo 
preview alongside 
shader support 
for V-Ray, Arnold, 
Redshift and 
Unreal



SOFTWARE REVIEW

Trapcode Tao 1.0
PRICE $99, £64 (available as part of the $999, £640 Trapcode Suite 13)  |  COMPANY Red Giant  |  WEBSITE www.redgiant.com

Object replicator 
system for Adobe 

After Effects

Works with masks, 
text and AE Light 

motion paths

Distort objects and 
paths using  
fractal noise

GPU accelerated 
performance

Features reflection 
mapping and 

ambient occlusion

MAIN 
FEATURES

Trapcode Tao, by Swedish 
developer Peder Norrby, is 
another wonderful plug-in 

for After Effects, enabling you to 
build complex 3D imagery with 
minimum effort. It’s basically a 
replicator, which arrays segments 
along a path – but Tao takes that 
basic idea and adds a wealth of 
options to provide almost unlimited 
scope. You can distort the path 
or segments using fractals, and 
then repeat the objects to produce 
complex geometric or organic 
patterns. The video tutorials on 
Red Giant’s website provide a 
comprehensive overview of the 
plug-in’s features.

Tao is fast (it’s GPU-accelerated), 
fun to use and it’s almost impossible 
not to make something that looks 
cool. Sadly, Tao objects don’t exist 
in the same 3D space as other AE 
layers, and so it can’t cast shadows 

on planes (or other Tao objects), 
and doesn’t self-shadow, although it 
does have ambient occlusion. Also, 
the objects don’t react to the AE 
camera’s depth of field, which is a 
shame as it’s crying out for shallow 
DOF effects. Also, for a future 
update it’d be great if it gave you 

the ability to import your own .obj 
files to act as the segment source, 
which would open up even more 
opportunities. Still, Tao is another 
excellent (and affordable) addition 
to the Trapcode Suite of plug-ins.

VERDICT

AUTHOR PROFILE
Steve Jarratt
Steve has been 
into CG for many 
years. He’s a regular 
contributor to 3D 
World and edited  
the magazine for  
two years.  
bit.ly/steve-jarratt

Tao can create anything 
from complex abstract 

patterns to writhing 
organic forms, with 

reflection mapping and 
ambient occlusion

SOFTWARE REVIEW

iClone 6 Character Creator
PRICE Free for iClone 6 Pro edition |  COMPANY Reallusion  |  WEBSITE www.reallusion.com

Unlimited 
variations in 

character

Rigged for 
animation in 

iClone

Controls for 
geometry, 

materials and 
props

MAIN 
FEATURES

Character creation is a 
particularly specialised 
task, but Reallusion might 

have the answer. For some artists, 
Character Creator might be a solid 
solution for generating quality 
humanoid figures.

It’s best to think of this iClone 6 
add-on as an extensive collection of 
morph targets, props and textures, 
for a few humanoid models. Similar 
functionality is available in other 
applications but not for free. Nor 
do they integrate with iClone, 
which is a big selling point, as that 
integration is where the power lies.

Character Creator is simple to 
use, but that belies the possibilities 
it presents, with pretty limitless 
variations available. Once a figure is 
selected it’s easy to choose attributes 
and make realtime changes. Controls 
are there for overall adaptions like 
age, ethnicity and weight, but you 

can drill down to make precise 
changes – preventing your character 
from looking too generic.

Reallusion have spent real 
development time ensuring there 
are many choices to help personalise 
figures – from refined makeup and 
skin tone controls, to elements of 

wear and tear, and even rips to add 
to clothing. The resulting figures are 
not at the pinnacle of quality; they’re 
not meant to be. They are rigged, 
and are easy to work with; perfect 
for pre-viz and visualisation work.

VERDICT

AUTHOR PROFILE
Rob Redman
Rob is an industry 
veteran, often found 
presenting at shows 
like FMX and THU. He 
runs courses covering 
VFX, animation  
and filmmaking.  
pariahstudios.co.uk

Character Creator allows 
you to design fully-rigged 
3D human models
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